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Sobre este Manual

Este manual fornece informações sobre instalação, configuração e trabalho com o
IBM

®

Netfinity
®

FAStT Storage Manager Versão 7.02 em um ambiente de sistema
operacional Microsoft

®

Windows
®

2000. Este Guia de Suporte e Instalação é escrito
para administradores do sistema. Utilize-o para:

v Determinar o hardware e o software requeridos para instalar o software de
gerenciamento de armazenamento.

v Integrar os componentes de hardware necessários na rede.

v Instalar o software de gerenciamento de armazenamento.

v Fazer upgrade do firmware do controlador, se necessário.

v Identificar os recursos de gerenciamento de armazenamento exclusivos do
Windows 2000.

Como este Manual está Organizado
O “Capítulo 1. Introdução” na página 1Capítulo 1, “Introdução”, na página 1, fornece
uma visão geral do IBM Netfinity FAStT Storage Manager Versão 7.02 e descreve
os métodos de gerenciamento de subsistemas de armazenamento, os tipos de
configuração e os tipos e requisitos de instalação.

O “Capítulo 2. Preparando para Instalação” na página 13 discute a preparação para
uma instalação de rede, incluindo a configuração de um servidor Microsoft DHCP
ou um servidor UNIX BOOTP, e descreve outras tarefas de configuração.

O “Capítulo 3. Instalando Software em uma Configuração Padrão” na página 29
fornece o procedimento para instalação do software em um ambiente padrão
(não-cluster).

O “Capítulo 4. Instalando o Software em um Ambiente de Servidor de Cluster” na
página 39 fornece o procedimento para instalação do software em um ambiente de
servidor de cluster.

O “Capítulo 5. Concluindo a Instalação” na página 51 descreve o Enterprise
Management e o Subsystem Management, alterando as definições de configuração
de NVSRAM e concluindo as tarefas de instalação.

O “Capítulo 6. Suporte do Sistema Operacional” na página 61 discute as restrições
do Windows 2000, usando o utilitário SM7devices e outros recursos de software.

O “Apêndice A. Avisos” na página 69 fornece avisos do produto e informações
sobre marcas.

O “Apêndice B. Registro das Informações do Subsistema/Controlador de
Armazenamento” na página 71 fornece um gabarito de planilha de dados utilizado
para criar um registro de informações do controlador.

Avisos Utilizados neste Manual
Este manual contém avisos para destacar informações ou fornecer informações
sobre segurança:

v Nota: Esses avisos fornecem dicas importantes, orientação ou conselho.

© Copyright IBM Corp. 2000 xi



v Atenção: Esses avisos indicam possíveis danos em programas, dispositivos ou
dados. Um aviso de atenção é colocado bem próximo à instrução ou situação na
qual o dano poderia ocorrer.

v Importante: Esses avisos fornecem informações que podem ajudá-lo a evitar
situações inconvenientes ou problemáticas.

Publicações Relacionadas
As publicações a seguir estão disponíveis no formato PDF (Portable Document
Format) do Adobe Acrobat no CD IBM Netfinity FAStT Storage Manager versão
7.02 e na World Wide Web, no endereço http://www.ibm.com/pc/support/

Nota: Os itens indicados por um asterisco (*) na lista significam publicações que
estão impressas e são fornecidas com os Servidores de Armazenamento
IBM FAStT200 e FAStT200 HA (High Availability).

v Guia de Suporte e Instalação do IBM Netfinity FAStT Storage Manager Versão
7.02 para Windows 2000 (este manual)

v Guia de Suporte e Instalação do IBM Netfinity FAStT Storage Manager Versão
7.02 para Windows NT

v Guia de Instalação e do Usuário dos Servidores de Armazenamento IBM
FAStT200 e FAStT200 HA

v IBM Netfinity Fibre Channel Storage Manager Concepts Guide

Quando você concluir as tarefas deste Guia de Suporte e Instalação, consulte o
auxílio online a seguir.

v IBM Netfinity FAStT Storage Manager Version 7.02 Enterprise Management
Online Help. Utilize este sistema de ajuda para obter mais informações sobre
como trabalhar com o domínio de gerenciamento.

v IBM Netfinity FAStT Storage Manager Version 7.02 Subsystem Management
Online Help. Utilize este sistema de ajuda para obter mais informações sobre
como gerenciar os subsistemas de armazenamento.

Os sistemas de ajuda podem ser acessados a partir das janelas Enterprise
Management e Subsystem Management no Netfinity FAStT Storage Manager 7.02.
Clique no menu Ajuda, na barra de ferramentas, ou pressione F1.

Os sistemas de ajuda contêm informações operacionais comuns a todos os
ambientes operacionais. Consulte este Guia de Suporte e Instalação para obter
informações específicas ao Windows 2000.

Publicações adicionais estão disponíveis para compra na IBM. Para obter uma lista
das publicações disponíveis em seu país:

v Nos EUA e em Porto Rico, ligue para 1-800-426-7282.

v No Reino Unido, ligue para 01705-565000 ou 0161-9056001.

v No Canadá, ligue para 1-800-465-1234.

v Em outros países, entre em contato com a organização de suporte da IBM que
atende sua área, o representante de marketing IBM ou o revendedor IBM.
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Capítulo 1. Introdução

Este guia de suporte e instalação fornece informações sobre a preparação, a
instalação, a configuração e o início do IBM Netfinity FAStT Storage Manager
Versão 7.02 em um ambiente Windows 2000. Este manual aplica-se aos
administradores do sistema. Antes de começar a instalação deste produto, consulte
a seguinte documentação:

v Arquivo Readme.txt - Leia este arquivo de texto primeiro. Está localizado no
diretório raiz do CD e contém as informações de usuário e instalação mais
recentes sobre componentes do software de gerenciamento de armazenamento
e componentes do hardware.

v IBM Netfinity Fibre Channel Concepts Guide - Utilize esse documento de
referência para familiarizar-se com a terminologia e com os recursos do software
de gerenciamento de armazenamento.

Quando tiver terminado todo o processo de instalação, consulte os sistemas de
Auxílio online a seguir, que contêm informações comuns a todos os ambientes de
sistemas operacionais. Para obter informações de instalação específicas ao
Windows 2000, consulte este manual.

v Ajuda da janela Enterprise Management - Utilize esse sistema de Auxílio online
para aprender mais sobre como trabalhar com o domínio de gerenciamento
completo.

v Ajuda da janela Subsystem Management - Utilize esse sistema de Auxílio online
para aprender mais sobre como gerenciar subsistemas de armazenamento
individuais.

Terminologia
Neste manual, o termo software de gerenciamento de armazenamento e Storage
Manager 7.02 referem-se ao IBM Netfinity FAStT Storage Manager Versão 7.02
como um todo. Este manual identifica por nome os componentes individuais do
software de gerenciamento de armazenamento. Consulte a tabela a seguir para
obter o status de informações sobre o produto com relação ao release do Storage
Manager 7.02.

Nome do produto Versão de
firmware do
release do
produto

Release da
versão do
software de
gerenciamento
de
armazenamento

Tipo de
máquina

Modelo

Netfinity FAStT200 4.x 7.02 3542 1RU

Netfinity FAStT200 HA 4.x 7.02 3542 2RU

Netfinity Fibre Channel RAID Controller Unit 3.x, 4x 7.01, 7.02 3526 1RU

Netfinity FAStT500 RAID Controller Enclosure Unit 4.x 7.01, 7.02 3552 1RU

Nota: O firmware do produto deve estar na versão 4.x para ser compatível com o
Storage Manager 7.02.

É importante que você se familiarize com a nova terminologia. Para obter uma lista
completa dos termos novos, consulte o IBM Netfinity Fibre Channel Storage
Manager Concepts Guide.

© Copyright IBM Corp. 2000 1



Visão Geral do Processo de Instalação
A instalação envolve o seguinte processo principal:

v Leitura de todo o conteúdo deste capítulo.

v “Capítulo 2. Preparando para Instalação” na página 13.

v “Capítulo 3. Instalando Software em uma Configuração Padrão” na página 29 ou
“Capítulo 4. Instalando o Software em um Ambiente de Servidor de Cluster” na
página 39.

v “Capítulo 5. Concluindo a Instalação” na página 51.

Sobre o Software de Gerenciamento de Armazenamento
O software de gerenciamento de armazenamento contém os seguintes
componentes:

v Software do Cliente

v Pacote do Agente de Host

v Pacote RDAC

Software do Cliente
O software de cliente do Storage Manager 7.02 fornece a GUI (interface gráfica
com o usuário) para o gerenciamento de subsistemas de armazenamento. Ele
apresenta dois componentes principais:

v Janela Enterprise Management. Utilize essa janela para adicionar, remover e
monitorar todos os subsistemas de armazenamento do domínio de
gerenciamento.

v Janela Subsystem Management. Utilize essa janela para gerenciar componentes
individuais do subsistema de armazenamento.

Pacote do Agente de Host
O pacote do agente de host do Storage Manager 7.02 consiste em dois
componentes de software:

v Software do agente de host . O software do agente de host pode ser utilizado
para gerenciar subsistemas de armazenamento por intermédio da conexão
Ethernet do host. O software do agente de host pega pedidos de uma estação
de gerenciamento que está conectada ao host por meio de uma conexão
Ethernet e os passa para os controladores do subsistema de armazenamento
utilizando o caminho de E/S do Fibre Channel. Para obter mais informações
sobre como gerenciar subsistemas de armazenamento por meio do agente de
host, consulte “Método Gerenciado pelo Agente de Host” na página 3.

v Utilitário SM7devices. O utilitário SM7devices pode ser utilizado para associar
unidades lógicas do subsistema de armazenamento com nomes de dispositivos
do sistema operacional. Para obter mais informações sobre como utilizar o
SM7devices, consulte “Usando o Utilitário SM7devices” na página 65.

Pacote RDAC
O pacote RDAC (Redundant Disk Array Controller) consiste no seguinte
componente de software:

Driver de dispositivo de vários caminhos RDAC . O driver de dispositivo de
vários caminhos RDAC fornece suporte de failover para o outro controlador se um
componente junto ao caminho de E/S do Fibre Channel falhar.
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Métodos de Gerenciamento do Subsistema de Armazenamento
O software de gerenciamento de armazenamento fornece dois métodos para
gerenciar os subsistemas de armazenamento — o método gerenciado pelo agente
de host e o método gerenciado diretamente. Dependendo das configurações
específicas do subsistema de armazenamento, é possível utilizar um ou ambos os
métodos.

Método Gerenciado pelo Agente de Host
Ao utilizar esse método, você gerencia os subsistemas de armazenamento
utilizando o caminho de E/S do Fibre Channel para o host. O subsistema de
armazenamento pode ser gerenciado a partir do computador host ou da estação de
gerenciamento que está conectada ao host por meio de uma conexão Ethernet.

As vantagens de se gerenciar subsistemas de armazenamento por meio do agente
de host são:

v Você não precisa estender cabos Ethernet para os controladores.

v Você não precisa de um servidor BOOTP para conectar-se à rede.

v Você não precisa executar as tarefas de configuração de rede do controlador
descritas no “Capítulo 2. Preparando para Instalação” na página 13.

v Ao adicionar dispositivos, é necessário especificar um nome de host ou
endereço IP apenas para o host, e não para os controladores individuais em um
subsistema de armazenamento. Os subsistemas de armazenamento conectados
ao host são descobertos automaticamente.

A desvantagem de se utilizar o método de agente de host é a seguinte:

v Você está limitado a configurar um LUN (Número da Unidade Lógica) a menos
que o número máximo permitido pelo sistema operacional e pela placa de host
que está sendo utilizada.

v O agente de host requer uma unidade lógica especial, chamada de volume de
acesso, para se comunicar com os controladores no subsistema de
armazenamento.

Nota: O volume de acesso utiliza um dos LUNs (números da unidade lógica). O
Windows NT permite um número máximo de LUNs, dependendo do Service
Pack que estiver instalado e da placa de host que estiver sendo utilizada.
Para obter mais informações, consulte “Número de Unidades Lógicas
Suportadas” na página 62.

Se você estiver fazendo upgrade dos controladores a partir da versão de firmware
3.x para a versão 4.x e o sistema host já tiver configurado o número máximo de
LUNs, você deverá ignorar um LUN para que seja utilizado como volume de
acesso.

Importante: O Windows 2000 permite um número máximo de LUNs, dependendo
da placa do host. Se o host já tiver o número máximo de LUNs configurado, utilize
o método gerenciado diretamente ou ignore um LUN para ser utilizado como o
volume de acesso. Para obter informações sobre sua configuração específica,
consulte “Número de Unidades Lógicas Suportadas” na página 62. Entre em

Capítulo 1. Introdução 3



contato com o suporte IBM para obter assistência adicional.

Método Gerenciado Diretamente
Nesse método, o software de cliente do gerenciamento de armazenamento é
utilizado para gerenciar o subsistema de armazenamento diretamente através da
rede, por meio da conexão Ethernet de cada controlador; veja a Figura 2 na
página 5. Para isso, você deve conectar um cabo a cada conexão Ethernet na
bandeja do controlador e definir o endereço IP e o nome do host de cada
controlador. As vantagens de se utilizar o método gerenciado diretamente são:

v Você pode utilizar uma estação de gerenciamento do Windows 2000 para
gerenciar subsistemas de armazenamento conectados a um host que esteja
utilizando um sistema operacional não suportado pelo software de
gerenciamento de armazenamento. Entre em contato com o suporte IBM para
obter mais informações.

v É possível configurar o número máximo de LUNs (números da unidade lógica)
suportado pelo sistema operacional e pelas placas do host. O método
gerenciado diretamente não requer um volume de acesso e não requer o uso de
um LUN.

As desvantagens de se utilizar esse método diretamente são:

v São necessários dois cabos Ethernet para conectar os dois controladores de
subsistema de armazenamento a uma rede.

v É necessário especificar um endereço IP ou um nome de host para cada
controlador ao adicionar subsistemas de armazenamento.

Figura 1. Subsistemas de armazenamento gerenciados pelo agente de host
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A Figura 2 mostra um sistema no qual os subsistemas de armazenamento são
gerenciados diretamente.

Tipos de Configuração
O Storage Manager 7.02 pode ser instalado em uma das duas configurações:

v Configuração padrão (não-cluster). Consulte a Tabela 1 na página 6.

v Configuração do servidor de cluster. Consulte a Tabela 2 na página 8.

Figura 2. Subsistema de armazenamento gerenciado diretamente
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Configuração Padrão (Não-Cluster)
A Tabela 1 indica onde os componentes de software do gerenciamento de
armazenamento são instalados em uma configuração padrão (não-cluster). A
Figura 3 na página 7 mostra uma configuração padrão (não-cluster) de amostra.

Tabela 1. Onde instalar componentes de software em uma configuração padrão (não-cluster)

Componente de software Local de instalação Notas

Storage Manager 7.x client
(SM7client)

O pacote de cliente pode ser
instalado em um dos seguintes
locais:

v Estação de gerenciamento
(para gerenciamento direto
ou pelo agente de host)

v Computador host (para uma
configuração que não utiliza
rede semelhante a versões
anteriores do software de
gerenciamento de
armazenamento)

v Estações de gerenciamento Se você instalar o
software SM7client em uma ou mais estações de
gerenciamento, poderá optar por gerenciar
subsistemas de armazenamento diretamente por
meio de conexões Ethernet aos controladores,
através da rede, por meio do agente de host, ou de
uma combinação de ambos os métodos.

v Computador host Se você instalar o software
SM7client no computador host, não será necessário
conectá-lo a uma rede se o software do agente de
host estiver instalado. Entretanto, o computador host
deverá ter o software TCP/IP instalado e você deverá
atribuir um endereço IP estático ao host.

RDAC Host O componente RDAC é necessário para suporte de
failover do controlador e para instalação e utilização do
software de agente de host. Certifique-se de instalar o
RDAC em cada host conectado ao subsistema de
armazenamento.

Storage Manager 7.02
Agent (SM7agent)

Host Você deve instalar o software SM7agent mesmo se
optar por não gerenciar subsistemas de armazenamento
com o software de agente de host. O agente de host
contém utilitários importantes que são necessários para
operar o software de gerenciamento de
armazenamento.
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A figura a seguir mostra um exemplo de configuração padrão (não-cluster).

Configuração do Servidor de Cluster
A tabela a seguir descreve os componentes do software de gerenciamento de
armazenamento que são instalados em um ambiente de servidor de cluster. Veja a
Figura 4 na página 9 para obter uma configuração do cluster de amostra.

Importante: Certifique-se de instalar todos os componentes de software de
gerenciamento de armazenamento em cada servidor do cluster.

Figura 3. Configurações padrão (não-cluster) de amostra
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Tabela 2. Onde instalar componentes de software em uma configuração de cluster

Componente de software Local de instalação Notas

Storage Manager 7.02 client
(SM7client)

O pacote SM7client pode ser
instalado em um dos
seguintes locais:

v Estação de gerenciamento
(para gerenciamento direto
ou pelo agente de host)

v Nós A e B (para
gerenciamento direto ou
pelo agente de host)

v Estações de gerenciamento Se você instalar o
software SM7client em uma ou mais estações de
gerenciamento, poderá optar por gerenciar
subsistemas de armazenamento diretamente por
meio de conexões Ethernet aos controladores,
através da rede, por meio do agente de host, ou
de uma combinação de ambos os métodos.

v Nós A e B Se você instalar o SM7client nos
servidores de cluster (nós A e B), não será
necessário conectar o servidor a uma rede se o
software do agente de host estiver instalado.
Entretanto, o computador host deverá ter o
software TCP/IP instalado e você deverá atribuir
um endereço IP estático ao servidor de cluster.

RDAC Nós A e B O RDAC é necessário para suporte de failover do
controlador e para instalação e utilização do software
de agente de host. Certifique-se de instalar o RDAC
em cada host conectado ao subsistema de
armazenamento.

Storage Manager 7.02 agent
(SM7agent)

Nós A e B Você deve instalar o agente de host mesmo se optar
por não gerenciar subsistemas de armazenamento
com o software de agente de host. O agente de host
contém utilitários importantes que são necessários
para operar o software de gerenciamento de
armazenamento.
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A Figura 4 mostra um exemplo de configuração de servidor de cluster.

Tipos de Instalação
Você pode instalar o software de gerenciamento de armazenamento em dois tipos
de ambientes de hardware:

v Novo ambiente de subsistema de armazenamento . Você está instalando
novos subsistemas de armazenamento com controladores que estão utilizando
versão de firmware 4.00.02, e que serão gerenciados com o Storage Manager
7.02. Vá para “Requisitos do Sistema” na página 10.

v Ambiente de subsistema de armazenamento existente . Você está instalando
o software de gerenciamento de armazenamento em um ambiente com
subsistemas de armazenamento existentes. Consulte a Tabela 3 na página 10
para obter as opções de instalação em um ambiente com subsistemas de
armazenamento existentes.

Figura 4. Configuração do servidor de cluster de amostra

Capítulo 1. Introdução 9



Tabela 3. Configurações para subsistemas de armazenamento existentes

Subsistemas de
armazenamento existentes
com:

Opções

Controladores (tipos de
máquinas: 3526 e 3552)
executando versões de
firmware de 4.00.00 a 4.00.01

Opção 1 — Certifique-se de remover a instalação da versão anterior do software de
gerenciamento de armazenamento antes de instalar a versão 7.02. Em seguida,
instale o Storage Manager 7.02 e atualize o firmware do controlador das versões
4.00.00 a 4.00.01 para a versão 4.00.02. Os subsistemas de armazenamento
existentes serão gerenciados com o Storage Manager 7.02. Vá para “Requisitos do
Sistema”.

Opção 2 — Continue a utilizar o firmware do controlador da versão 4.00.00 a
4.00.01 existente. Certifique-se de remover a instalação da versão anterior do
software de gerenciamento de armazenamento antes de instalar a versão 7.02.
Esses subsistemas de armazenamento existentes podem ser gerenciados
utilizando-se o Storage Manager 7.02, que inclui componentes compatíveis com
essas versões anteriores de firmware. As diferenças funcionais entre o firmware do
controlador existente e o firmware do controlador (4.00.02) são fornecidas no CD de
instalação. Consulte o arquivo README localizado no diretório \W2K\ do CD de
instalação para obter mais informações. Vá para “Requisitos do Sistema”.

Controlador (tipo de máquina:
3526) executando versão de
firmware 3.x

Opção 1 — Se estiver fazendo upgrade a partir do Windows NT 4.0 para o Windows
2000, utilize o processo de migração do Windows NT para fazer upgrade dos
controladores para a versão de firmware 4.00.02; em seguida, faça upgrade do
sistema operacional do Windows NT para o Windows 2000. Para obter mais
informações, consulte a Tabela 9 na página 29.

Requisitos do Sistema
Esta seção fornece informações detalhadas sobre os requisitos de hardware, de
software e operacionais do Storage Manager 7.02.

Requisitos de Hardware
A Tabela 4 relaciona o hardware requerido para instalação do Storage Manager
7.02.

Tabela 4. Requisitos de hardware do software do gerenciador de armazenamento

Componente de hardware Requisitos

Um servidor BOOTP (apenas para
subsistemas de armazenamento
gerenciado diretamente).

v Servidor DHCP compatível com BOOTP da Microsoft para Windows
®

v Servidor UNIX
®

BOOTP

Subsistemas de armazenamento (um
ou mais).

Subsistemas de armazenamento com controladores executando versão de
firmware de 4.00.00 a 4.00.02
Nota: Leia “Tipos de Instalação” na página 9 para obter informações sobre
como gerenciar esses subsistemas de armazenamento quando subsistemas de
armazenamento existentes estiverem conectados fisicamente ao mesmo host
que será conectado aos novos subsistemas de armazenamento.

Placas de host FC (Fibre Channel). As seguintes placas de host Fibre Channel foram testadas com o software de
gerenciamento de armazenamento:

v Placa de host IBM Netfinity FAStT (número de peça: 00N6881)

Para obter informações sobre os requisitos específicos da placa de host:

v Consulte o diretório \W2K\Host_Adapter no CD de instalação.

v Leia a documentação da placa de host.

v Consulte o site da IBM na Web em: http://www.ibm.com/pc/support
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Tabela 4. Requisitos de hardware do software do gerenciador de armazenamento (continuação)

Componente de hardware Requisitos

Chaves de estrutura FC (Fibre
Channel) (se forem necessárias para
a configuração desejada).

As seguintes chaves de estrutura Fibre Channel foram testadas com o
software de gerenciamento de armazenamento:

v Chave Fibre Channel de 8 portas da IBM (tipo de máquina: 2109-S08)

v Chave Fibre Channel de 16 portas da IBM (tipo de máquina: 2109-S16)

Para obter os requisitos específicos de configuração da chave Fibre Channel:

v Leia a documentação da chave.

v Consulte o site da IBM na Web em http://www.ibm.com/products

Hub gerenciado FC (Fibre Channel)
(se for necessário para a
configuração desejada).

O seguinte hub gerenciado foi testado com o software de gerenciamento de
armazenamento:

v Hub gerenciado IBM Fibre Channel (tipo de máquina: 3534)

Para obter os requisitos específicos de configuração do hub gerenciado Fibre
Channel:

v Leia a documentação do hub gerenciado.

v Consulte o site da IBM na Web em http://www.ibm.com/products

Requisitos de Espaço em Disco e de Privilégio de Administradores
A tabela 5 relaciona o espaço em disco e os privilégios de administrador
necessários para instalação da nova versão do software de gerenciamento de
armazenamento.

Tabela 5. Requisitos de espaço em disco e de privilégios de administrador

Pacote Requisito de espaço em disco Privilégio de administrador

Cliente 35 MB Não requerido

RDAC 1 MB Requerido

Agente de host 1 MB Requerido

Requisitos do Sistema Operacional
Cada estação de gerenciamento, computador host ou servidor de cluster requer um
dos seguintes sistemas operacionais:

Estações de gerenciamento e computadores host . Instale um dos seguintes
sistemas operacionais:

v Windows 2000 Server

v Windows 2000 Professional

v Windows 2000 Advanced Server (requerido para um ambiente de cluster).

Servidores de cluster . Instale o sistema operacional Windows 2000 Advanced
Server.

Se você estiver fazendo upgrade do Windows NT 4.0 para o Windows 2000 em
uma configuração padrão (não-cluster), vá para “Fazendo Upgrade do Windows NT
4.0 para o Windows 2000 em uma Configuração Padrão” na página 13.
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Se você estiver fazendo upgrade do Windows NT 4.0 para o Windows 2000 em
uma configuração de cluster, vá para “Fazendo Upgrade do Windows NT 4.0 para
o Windows 2000 em uma Configuração de Cluster” na página 13.

Se você não estiver fazendo upgrade do Windows NT para o Windows 2000, vá
para “Decidindo como Gerenciar os Subsistemas de Armazenamento” na
página 15.

12 IBM
®

Netfinity
®

FAStT Storage Manager Versão 7.02 para Windows
®

2000: Guia de Suporte e Instalação



Capítulo 2. Preparando para Instalação

Este capítulo ajuda a planejar e a preparar a instalação do software de
gerenciamento de armazenamento.

Fazendo Upgrade do Windows NT 4.0 para o Windows 2000 em uma
Configuração Padrão

Se o Windows 2000 já estiver instalado como o sistema operacional, vá para
“Decidindo como Gerenciar os Subsistemas de Armazenamento” na página 15.

Importante: Para evitar possível perda de dados, você deve seguir as instruções
de remoção de instalação de versões anteriores do software de gerenciamento de
armazenamento, incluindo o RDAC, antes de fazer upgrade do Windows NT 4.0
para o Windows 2000.

Não será possível fazer upgrade do Windows NT para o Windows 2000 se o
subsistema de armazenamento for o dispositivo de inicialização.

Nota: Os controladores deverão estar executando o firmware 4.x antes do
upgrade.

Siga estas etapas para fazer upgrade do Windows NT 4.0 para o Windows 2000:

1. Certifique-se de que o subsistema de armazenamento não contenha arquivos
ou diretórios dependentes do sistema, tais como arquivos de paginação.

Nota: Todas as informações de configuração são excluídas durante o processo
de remoção da instalação. Será necessário instalar o software de
gerenciamento de armazenamento como se fosse a primeira vez.

2. Remova a instalação do software de gerenciamento de armazenamento
utilizando o procedimento de remoção da instalação fornecido com a versão do
software de gerenciamento de armazenamento que está sendo utilizado
atualmente. Não utilize o procedimento fornecido neste manual.

3. Utilize as instruções da Microsoft para fazer upgrade para o Windows 2000.

4. Instale o Storage Manager 7.02 como uma nova instalação, seguindo as
instruções iniciais de “Decidindo como Gerenciar os Subsistemas de
Armazenamento” na página 15.

Fazendo Upgrade do Windows NT 4.0 para o Windows 2000 em uma
Configuração de Cluster

Se o Windows 2000 já estiver instalado como seu sistema operacional, vá para
“Decidindo como Gerenciar os Subsistemas de Armazenamento” na página 15.

Nota: Para evitar a perda de acesso a um cluster, será necessário fazer um
upgrade com funções em andamento. Isso significa fazer upgrade de forma
que os serviços e recursos oferecidos pelo cluster estejam sempre
disponíveis, apesar de os nós dos quais se está fazendo upgrade não
estarem disponíveis.

Se houver aplicativos instalados no ambiente de cluster que não suportem
um upgrade com funções em andamento, você terá que:
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v Colocar esses recursos offline antes do upgrade e colocá-los novamente
online posteriormente, ou

v Utilizar um método diferente de upgrade
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Siga estas etapas para fazer upgrade do Windows NT 4.0, Edição Corporativa,
para o Windows 2000 Advanced Server:

1. Depois de instalar o servidor de cluster, reinstale o Service Pack mais recente
do NT 4.0 (Service Pack 5.0 ou posterior).

2. No nó A, abra o Cluster Administrator.

3. Destaque e interrompa o nó A (File → Pause Node ).

4. Dê um clique duplo na pasta Active Groups na janela à direita do Cluster
Administrator.

5. Selecione cada grupo relacionado e mova-o para o nó B.

6. Remova a instalação de todos os componentes de software de gerenciamento
de armazenamento do nó A. Não utilize o procedimento fornecido neste
manual. Remova a instalação do software de gerenciamento de
armazenamento utilizando o procedimento de remoção da instalação que vem
com a versão do software de gerenciamento de armazenamento que está
sendo utilizado atualmente.

7. Siga as instruções da Microsoft para fazer upgrade do nó A do Windows NT
para o Windows 2000 Advanced Servers.

Nota: Durante o upgrade, a instalação existente do servidor de cluster será
detectada e o cluster para o Windows 2000 Advanced Server será
instalado. Após o término do upgrade, o nó A será reunido ao cluster,
mas ainda estará interrompido.

8. Verifique se as versões do driver HBA (Host Bus Adapter) estão corretas. Se
não forem a versão certificada, utilize o arquivo README no diretório
\W2K\Host_Adapter do CD de instalação para fazer upgrade das versões de
driver antes de continuar.

9. Verifique se o upgrade do nó A foi feito com êxito para o Windows 2000
Advanced Server.

10. Instale o RDAC para Windows 2000 no nó A.

11. Instale os componentes do Storage Manager 7.02 para Windows 2000
(SM7client e SM7agent)

12. Execute o Cluster Administrator e continue no nó (File → Resume Node ).

13. Repita as etapas de 1 a 12 no nó B.

14. Instale o Storage Manager 7.02 como uma nova instalação, seguindo as
instruções iniciais de “Decidindo como Gerenciar os Subsistemas de
Armazenamento”.

Decidindo como Gerenciar os Subsistemas de Armazenamento
Se ainda não tiver consultado o “Capítulo 1. Introdução” na página 1, consulte-o
para obter informações sobre os dois seguintes métodos de gerenciamento de
subsistemas de armazenamento:

v Gerenciamento direto por meio de uma conexão Ethernet com cada controlador
no subsistema de armazenamento

v Gerenciamento pelo agente de host por meio do software do agente de host
instalado no computador host que está conectado ao subsistema de
armazenamento

Vocêpode utilizar um ou ambos os métodos. Entretanto, como muitas das tarefas
de preparação para instalação dependem do método que será utilizado, antes de
começar, decida como deseja gerenciar os subsistemas de armazenamento de sua
rede.
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Revisando uma Rede de Amostra
A Figura 5 mostra o exemplo de uma configuração de rede do subsistema de
armazenamento gerenciado diretamente (veja a rede A). Essa rede contém os
seguintes componentes:

v Servidor BOOTP

v Estação de gerenciamento (NMS) para traps do SNMP (Simple Network
Management Protocol)

v Host conectado a um subsistema de armazenamento por meio de um caminho
de E/S do Fibre Channel

v Estação de gerenciamento conectada pelo cabo Ethernet aos controladores do
subsistema de armazenamento

A Figura 5 mostra o exemplo de uma configuração de rede do subsistema de
armazenamento gerenciado pelo agente de host (veja a rede B). Essa rede contém
os seguintes componentes:

v Um host conectado a um subsistema de armazenamento por meio de um
caminho de E/S do Fibre Channel

v Uma estação de gerenciamento conectada pelo cabo Ethernet ao host

Vá para “Preparando para uma Instalação de Rede” na página 17.

Figura 5. Rede de amostra utilizando subsistemas de armazenamento gerenciados
diretamente e pelo agente de host
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Preparando para uma Instalação de Rede
Antes de instalar o software de gerenciamento de armazenamento, certifique-se de
que os componentes de rede estejam configurados e funcionando adequadamente,
e de que possua todas as informações do host e do controlador necessárias para
que o software opere corretamente. Para isso, execute as tarefas resumidas na
Tabela 6 (que se refiram aos procedimentos apropriados). Utilize a Tabela 12 na
página 71 como uma planilha de dados para registrar informações do subsistema
de armazenamento e do controlador. Um exemplo de registro de informações
concluído é mostrado na Tabela 7 na página 19.

Tabela 6. Resumo da tarefa de preparação da rede

Tarefa de execução Direto ou pelo
agente de host?

Por que executar esta
tarefa?

Para obter instruções,
consulte:

Etapa 1 - Instalar todos os
componentes de hardware
(computadores host,
subsistemas de armazenamento,
cabos e outros) que desejar
conectar à rede.

Direto e pelo
agente de host

Para garantir que o hardware
da rede esteja presente.

O guia de instalação específico
dos componentes de hardware.

Etapa 2 - Estabelecer e registrar
uma convenção de nomenclatura
para os subsistemas de
armazenamento conectados à
rede.

Direto e pelo
agente de host

Para adicionar os
subsistemas de
armazenamento ao domínio
de gerenciamento depois da
instalação do software.

“Decidindo como Nomear os
Subsistemas de
Armazenamento” na página 19.

Etapa 3 - Determinar o endereço
Ethernet do hardware de cada
controlador em todos os
subsistemas de armazenamento
conectados à rede.

Direto Para configurar o servidor
BOOTP para fornecer
informações de configuração
da rede aos controladores.

“Identificando o Endereço
Ethernet do Hardware de Cada
Controlador” na página 21.

Etapa 4 - Obter endereços IP e
nomes de host do administrador
da rede.

Direto e pelo
agente de host

Para gerenciamento pelo
agente de host, são
necessários os endereços IP
e os nomes do host nos
quais o software do agente
de host será executado. Para
gerenciamento direto, são
necessários os endereços IP
de cada controlador nos
subsistemas de
armazenamento para
configurar o servidor BOOTP.
O servidor BOOTP pode,
então, fornecer informações
de configuração da rede para
os controladores. Os
endereços IP dos
controladores também são
utilizados para configurar a
tabela do host ou do DNS.

“Obtendo Endereços IP para
Hosts e Controladores” na
página 23

Etapa 5 - Configurar o servidor
BOOTP para fornecer
informações de configuração da
rede para um controlador
específico.

Direto Para fornecer informações de
configuração da rede aos
controladores, utilizando o
servidor BOOTP.

“Configurando o Servidor
BOOTP” na página 23.
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Tabela 6. Resumo da tarefa de preparação da rede (continuação)

Tarefa de execução Direto ou pelo
agente de host?

Por que executar esta
tarefa?

Para obter instruções,
consulte:

Etapa 6 - Verificar se o software
TCP/IP está instalado e
configurar a tabela do host ou do
DNS.

Direto Instalar o software de cliente
em uma estação de
gerenciamento garante que
ela esteja configurada para
alcançar os controladores na
rede.

“Verificar o Protocolo TCP/IP e
Configurar a Tabela do Host ou
do DNS” na página 27.

Etapa 7 - Ativar os dispositivos
conectados à rede.

Direto e pelo
agente de host

Para garantir que todos os
dispositivos e links estejam
operacionais.

O guia de instalação específico
dos componentes de hardware.

18 IBM
®

Netfinity
®

FAStT Storage Manager Versão 7.02 para Windows
®

2000: Guia de Suporte e Instalação



A tabela a seguir mostra um registro de informações de amostra com entradas para
um subsistema de armazenamento gerenciado diretamente e um subsistema de
armazenamento gerenciado pelo agente de host.

Tabela 7. Registro de informações de amostra

Nome do
subsistema de
armazenamento
(consulte a
página 19)

Tipo de
gerenciamento
(consulte a
página 15)

Controladores—Endereços
Ethernet e IP, e nome do host
(consulte as páginas 2117 e 2318)

Host—Endereços
IP e nome do
host (consulte a
página 2318)

Controlador A Controlador B

Nome do
subsistema de
armazenamento:
Finance

Direto Endereço
Ethernet do
hardware =
00a0b8020420

Endereço
Ethernet do
hardware =
00a0b80000d8

Endereço IP =
192.168.1.13

Endereço IP =
192.168.1.14

Host = Denver_a Host = Denver_b

Nome do
subsistema de
armazenamento:
Engineering

Agente de host Endereço IP =
192.168.2.22

Host = Atlanta

A Tabela 12 na página 71 fornece uma planilha de dados na qual você pode
registrar nomes do subsistema de armazenamento, tipos de gerenciamento,
endereços Ethernet do hardware e endereços IP. Faça uma cópia dessa tabela e
conclua as informações dos subsistemas e controladores de armazenamento.
Utilize as informações registradas na Tabela 12 para configurar a tabela BOOTP
para o servidor de rede e para a tabela do host ou do DNS (Domain Name
System). As informações da Tabela 12 ajudam a adicionar subsistemas de
armazenamento após a instalação inicial. Os títulos das colunas mostram uma
referência de página para que se obtenha instruções detalhadas sobre como obter
as informações. Para obter um registro de informações de amostra, consulte a
Tabela 7.

Concluindo as Tarefas de Preparação
Além das informações de tarefas mencionadas na Tabela 6 na página 17, a lista a
seguir contém tarefas que precisarão ser executadas para que você esteja pronto
para a instalação do Storage Manager 7.02.

v “Decidindo como Gerenciar os Subsistemas de Armazenamento” na página 15.

v “Identificando o Endereço Ethernet do Hardware de Cada Controlador” na
página 21.

v “Obtendo Endereços IP para Hosts e Controladores” na página 23.

v “Configurando o Servidor BOOTP” na página 23.

v “Verificar o Protocolo TCP/IP e Configurar a Tabela do Host ou do DNS” na
página 27.

v “Ativando Portas para Operação por meio de um Firewall” na página 28.

Decidindo como Nomear os Subsistemas de Armazenamento
Enquanto você configura a rede, decida sobre a convenção de nomenclatura para
os subsistemas de armazenamento. Depois de instalar o software de
gerenciamento de armazenamento e iniciá-lo pela primeira vez, todos os

Capítulo 2. Preparando para Instalação 19



subsistemas de armazenamento do domínio de gerenciamento são exibidos como
<unnamed>. Utilize a janela Subsystem Management para renomear os subsistemas
de armazenamento individuais.
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A lista a seguir fornece dicas para nomear os subsistemas de armazenamento:

v Há um limite de 30 caracteres. Todos os espaços iniciais e finais são excluídos
do nome.

v Utilize um esquema de nomenclatura exclusivo, significativo, que seja fácil de
entender e de lembrar.

v Evite nomes arbitrários ou nomes que perderiam rapidamente seu significado no
futuro.

v O software exibe nomes do subsistema de armazenamento com o prefixo
Storage Subsystem. Portanto, se você renomear um subsistema de
armazenamento para Engineering, ele será exibido como Storage Subsystem
Engineering .

Depois de ter decidido sobre um esquema de nomenclatura, registre os nomes do
subsistema de armazenamento no registro de informações (Tabela 12 na
página 71).

Se estiver gerenciando diretamente o subsistema de armazenamento, vá para
“Identificando o Endereço Ethernet do Hardware de Cada Controlador”. Se for
gerenciar o subsistema de armazenamento por meio do agente de host, vá para
“Obtendo Endereços IP para Hosts e Controladores” na página 23.

Identificando o Endereço Ethernet do Hardware de Cada Controlador
Utilize o procedimento a seguir caso planeje gerenciar diretamente os subsistemas
de armazenamento por meio de conexões Ethernet com cada controlador. Se
planeja gerenciar subsistemas de armazenamento utilizando o software do agente
de host, ignore este procedimento e vá para “Obtendo Endereços IP para Hosts e
Controladores” na página 23.

1. Remova o engate frontal da unidade do controlador (tipos de máquinas 3526 e
3552), conforme mostrado na Figura 6. Cuidadosamente, retire a parte inferior
do engate para liberar os pinos «1¬; em seguida, deslize o engate para baixo
«2¬.

Figura 6. Removendo o engate da unidade de controlador dos tipos de máquinas 3526 e
3552
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2. Destrave e abra as alavancas nos controladores RAID (modelos 3526 e 3552).

3. Na frente de cada controlador, procure uma etiqueta com o endereço Ethernet
do hardware do controlador, conforme mostrado na Figura 7 e Figura 8.

O número estará no formato xx.xx.xx.xx.xx.xx (por exemplo, 00.a0.b8.00.00.d8).

4. Registre cada endereço Ethernet no registro de informações (Tabela 12 na
página 71).

5. Para substituir o engate nos tipos de máquinas 3526 e 3552, deslize a borda
superior sob a aba no chassi «1¬; em seguida, empurre a parte inferior do
engate até que os pinos sejam engatados nos orifícios de montagem «2¬,

Figura 7. Localização das etiquetas do endereço Ethernet do hardware nos tipos de
máquinas 3526 e 3552

Figura 8. Localização das etiquetas do endereço Ethernet do hardware no tipo de máquina
3542
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conforme mostrado na Figura 9.

6. Continue em “Obtendo Endereços IP para Hosts e Controladores”.

Obtendo Endereços IP para Hosts e Controladores

Se você Vá para

Gerencia subsistemas de armazenamento diretamente Etapa 1

Gerencia subsistemas de armazenamento com o agente de host Etapa 2

Nota: Se você pretende gerenciar alguns subsistemas de armazenamento diretamente e
outros com o software do agente de host, conclua as duas etapas a seguir.

1. Atribua (ou obtenha com o administrador da rede) um endereço IP exclusivo e
o nome de host associado de cada controlador em cada subsistema de
armazenamento na rede. Registre o endereço IP e o nome do host de cada
controlador no registro de informações (Tabela 12 na página 71). Em seguida,
vá para o servidor BOOTP “Configurando o Servidor BOOTP”.

2. Entre em contato com o administrador da rede para obter o endereço IP e o
nome do host de cada host no qual planeja instalar o software do agente de
host para gerenciar subsistemas de armazenamento. Registre o endereço IP e
o nome do host do host no registro de informações (Tabela 12 na página 71).
Em seguida, vá para “Verificar o Protocolo TCP/IP e Configurar a Tabela do
Host ou do DNS” na página 27.

Configurando o Servidor BOOTP
Se você planeja gerenciar diretamente os subsistemas de armazenamento por
meio da conexão Ethernet com cada controlador, selecione o procedimento que
planeja utilizar para configurar o servidor BOOTP:

Selecione o procedimento apropriado para configurar o servidor BOOTP.

v Ao utilizar o DHCP compatível com BOOTP da Microsoft, vá para “Utilizando o
DHCP da Microsoft como um Servidor Compatível com BOOTP” na página 24.

v Ao utilizar o UNIX BOOTP, continue em “Utilizando um Servidor UNIX BOOTP”
na página 26.

Figura 9. Substituindo o engate da unidade de controlador nos modelos 3526 e 3552

Capítulo 2. Preparando para Instalação 23



v Se você planeja gerenciar subsistemas de armazenamento utilizando o software
do agente de host, vá para “Verificar o Protocolo TCP/IP e Configurar a Tabela
do Host ou do DNS” na página 27.

Utilizando o DHCP da Microsoft como um Servidor Compatível com
BOOTP

Você deve utilizar uma versão do DHCP (Dynamic Host Configuration Protocol) que
suporte endereçamento estático de BOOTP. Para utilizar um servidor DHCP, um
DHCP Manager deverá estar instalado. Se um DHCP Manager estiver instalado no
sistema, vá para “Configurando um Servidor DHCP”. Se um DHCP Manager não
estiver instalado, utilize o procedimento de instalação a seguir.

Utilize o procedimento a seguir para instalar o DHCP Manager:

1. Clique em Start → Settings → Control Panel → Add/Remove Programs

2. Na janela Network que se abre, role e clique em Networking Services →
Details .

3. Em Subcomponents of Networking Services, marque a caixa próxima à
Dynamic Host Configuration Protocol e clique em OK.

4. Se solicitado, digite o caminho completo para os arquivos de distribuição do
Windows 2000 e clique em Continue .

Os arquivos necessários serão copiados para a unidade de disco rígido. O
software de servidor pode ser utilizado depois de o sistema ser reinicializado.

5. Continue em “Configurando um Servidor DHCP”.

Nota: Depois de instalar o DHCP Manager, você pode consultar sua auxílio online
para obter informações adicionais.

Configurando um Servidor DHCP
Utilize o procedimento a seguir para criar um escopo e configurar o servidor DHCP.
Um escopo define um grupo de controladores por seus endereços IP. Você deve
criar e configurar um escopo para que endereços IP dinâmicos possam ser
atribuídos aos controladores na rede. Consulte as informações fornecidas no
“Apêndice B. Registro das Informações do Subsistema/Controlador de
Armazenamento” na página 71. Antes de começar, leia as instruções para
determinar as informações necessárias e, em seguida, solicite-as do administrador
da rede.

Nota: As etapas e o exemplo de janela a seguir supõem que você esteja
configurando um servidor DHCP do Windows 2000 por meio do DHCP
Manager.

1. Clique em Start → Programs → Administrative Tools → DHCP Manager .

A janela DHCP Manager é aberta.

2. Destaque o servidor que você deseja configurar.

A janela add a scope é aberta. Utilize as instruções a seguir.

1.

a. Digite um nome e uma descrição para o escopo.
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b. Digite os endereços IP iniciais e finais dos controladores que estão sendo
configurados na rede.

Por exemplo, se você estiver configurando 50 controladores em uma
sub-rede 192.168.1.0, defina o endereço inicial para 192.168.1.1 e o
endereço final para 192.168.1.50.

Nota: Se cada campo não possuir no mínimo três caracteres, pressione a
tecla de ponto (.) para avançar para o campo seguinte. Se você tiver
apenas um controlador, digite seu endereço para ambos os
endereços, inicial e final.

c. Digite a máscara de sub-rede (obtida com o administrador da rede).

d. Utilizando a tela Add Exclusions, digite os endereços IP que precisam ser
excluídos dos endereços iniciais e finais recém-digitados na etapa b e, sem
seguida, clique em Add .

e. Defina o Lease Duration (obtido com o administrador da rede).

f. Configure as opções de DHCP:

Nota: Certifique-se de configurar as opções de DHCP nesse momento.
Para configurar as opções posteriormente, vá para a tela DHCP e
abra a estrutura de diretórios do Escopo que você criou na etapa 2.
Dê um clique com o botão direito do mouse em Scope Options →
Configure Options ανδ φολλοω τηN ινστρυχτιονσ.

1) Para configurar as opções de DHCP, comece adicionando um endereço
IP para um roteador.

2) Adicione os servidores de nome de domínio e DNS.

3) Digite o nome do servidor e o endereço IP na janela WINS Servers.

4) Quando o escopo tiver sido concluído com êxito, clique em Yes para
ativá-lo.

Você retorna à janela DHCP Manager.

2. Abra a estrutura de diretórios abaixo do escopo criado na etapa 1 na página 24.

Figura 10. Janela Create scope - (Local)
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3. Dê um clique com o botão direito do mouse em Reservation, selecione New
Reservation e siga as instruções.

Importante: Na parte inferior da janela New Reservations, faça uma seleção em
Supported Type. Certifique-se de selecionar ambos.

a. Clique em General Tab . Role pela lista e selecione Host Name .

b. Digite um nome de host específico para cada controlador. Certifique-se de
utilizar o mesmo nome atribuído como o nome de reserva.

c. Repita a etapa 4 até ter adicionado os nomes de host para todos
oscontroladores.

d. Quando terminar de digitar as informações para todos os controladores,
clique em Close.

4. Quando tiver terminado de configurar o servidor DHCP, você deverá reciclar a
energia antes de qualquer modificação no DHCP ser efetivada. Se o
subsistema de armazenamento estiver ativado, para reciclar a energia, desative
os subsistemas de armazenamento. Em seguida, ative-os.

5. Continue em “Verificar o Protocolo TCP/IP e Configurar a Tabela do Host ou do
DNS” na página 27.

Utilizando um Servidor UNIX BOOTP
A Tabela 8 e a Tabela 12 na página 71 fornecem informações para configuração da
tabela BOOTP e realização das entradas requeridas para suportar os controladores
nos subsistemas de armazenamento. Utilize um editor de texto para editar o
arquivo bootptab no diretório /etc.

Tabela 8. Entradas requeridas para configuração do servidor UNIX BOOTP

Entrada Descrição Formato de amostra
no servidor BOOTP

Máscara de
sub-rede

Máscara utilizada para rotear pacotes para
sub-redes definidas.

notação por pontos
(sm=255.255.255.0)

Roteador Endereço IP do computador host que roteia
pacotes para as sub-redes.

notação por pontos
(gw=192.168.1.1)

Nome do host do
controlador

Nome do host que está associado ao
controlador (consulte a Tabela 12 na
página 71).

nome do host
(Denver_a)

Endereço IP Endereço IP do controlador (consulte a
Tabela 12 na página 71).

notação por pontos
(ip=192.168.1.13)

Endereço
Ethernet

O endereço Ethernet do hardware do
controlador (consulte a Tabela 12 na
página 71).

notação hexadecimal
(ha=00a0b8020420)

Nota: As entradas RMS e NMS utilizadas em versões anteriores do software de
gerenciamento de armazenamento versão 6.22 não são necessárias ao
utilizar o Storage Manager 7.02 para gerenciar subsistemas de
armazenamento com controladores que estejam executando versão de
firmware 4.x.

Exemplo para Edição de uma Tabela UNIX BOOTP
O exemplo a seguir de uma tabela BOOTP supõe que você esteja configurando um
servidor UNIX BOOTP, tal como um servidor na Rede A, conforme mostrado na
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Figura 5 na página 16. A entrada s4.default:\ denota definições que são comuns a
todos os controladores. A entrada tc=s4.default:\ associa este grupo de definição
comum a um controlador específico.

s4.default:\ (definições comuns)

ht=ether:\ sm=255.255.248.0:\ gw=192.168.1.1:\ hn: denver_a:\ tc=s4.default:\
(refere-se a definições comuns) ip=192.168.1.13:\ ha=00a0b8020420: denver_b:\
tc=s4.default:\ ip=192.168.1.14:\ ha=00a0b80000d8:

Quando você terminar de configurar a tabela BOOTP, execute o seguinte:

1. Se o subsistema de armazenamento estiver ativado, desative o subsistema e,
em seguida, ative os subsistemas de armazenamento.

Você deve reinicializar os subsistemas de armazenamento para que os
parâmetros da tabela BOOTP sejam efetivados.

2. Vá para “Verificar o Protocolo TCP/IP e Configurar a Tabela do Host ou do
DNS”.

Verificar o Protocolo TCP/IP e Configurar a Tabela do Host ou do DNS
Certifique-se de que os nomes de host do controlador correspondam aos
endereços IP apropriados dos controladores. Utilize o procedimento a seguir para
verificar se o software do protocolo TCP/IP está instalado na estação de
gerenciamento e para configurar a tabela do host ou do DNS (Domain Name
System).

Nota: Você pode optar por utilizar o WINS (Windows Internet Name Service) em
vez do DNS.

1. Clique em Start → Settings → Control Panel → Network → Properties para
verificar se o software TCP/IP está instalado e configurado adequadamente.

Nota: O software TCP/IP não está instalado, instale-o a partir do CD de
Instalação do Windows 2000. Clique em Start → Settings → Control
Panel → Network → Properties → Install → Protocols → Add .

2.

Atualize a tabela do host ou do DNS para especificar um nome de host a ser
associado a um endereço IP. Se você não tiver um DNS (ou WNS), edite as
duas tabelas do host encontradas nos diretórios a seguir.
c:\winnt\system32\drivers\etc\hosts

c:\winnt\system32\drivers\etc\imhosts

Por exemplo, para configurar as tabelas do host dos controladores conectados
à Rede A (Figura 5 na página 16), utilize um editor de texto para criar as
entradas de endereço IP e de nome do controlador a seguir.

Endereço IP Nome do host do controlador

127.0.0.01 localhost

192.168.1.13 denver_a

192.168.1.14 denver_b

Importante: Ocorrem riscos potenciais de segurança ao abrir portas para a
rede.

3. Para gerenciar subsistemas de armazenamento por meio de um firewall,
continue em “Ativando Portas para Operação por meio de um Firewall”.
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Ativando Portas para Operação por meio de um Firewall
Se planeja gerenciar subsistemas de armazenamento por meio de um firewall de
filtragem de pacotes, configure o firewall para abrir a porta 2463 para dados TCP.

Preparando para Instalar o Software de Gerenciamento de
Armazenamento

Você concluiu as tarefas de preparação e está pronto nesse momento, para instalar
o software de gerenciamento de armazenamento. O processo de instalação a ser
seguido depende de como você deseja configurar o sistema.

Se você Vá para

Instalar o software em uma configuração
padrão (não-cluster)

“Capítulo 3. Instalando Software em uma
Configuração Padrão” na página 29.

Instalar o software em um ambiente de
servidor de cluster

“Capítulo 4. Instalando o Software em um
Ambiente de Servidor de Cluster” na
página 39.
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Capítulo 3. Instalando Software em uma Configuração Padrão

Este capítulo descreve como instalar o software de gerenciamento de
armazenamento em uma configuração padrão (não-cluster).

Importante: Sempre verifique se há um arquivo README em qualquer mídia de
instalação. Ele pode conter informações importantes que não estavam disponíveis
quando este Guia de Suporte e Instalação foi preparado.

Processo de Pré-instalação
Há duas configurações nas quais você pode instalar o software de gerenciamento
de armazenamento:

v A que não tem subsistemas de armazenamento existentes.

v A que tem subsistemas de armazenamento existentes.

Utilize a Tabela 9 para determinar um processo de instalação.

Tabela 9. Determinando o processo de instalação

Ambiente atual Ambiente planejado Ação

Subsistemas de armazenamento
não-existentes

Novos subsistemas de
armazenamento com controladores
que utilizarão um firmware versão
4.00.02 e serão gerenciados com o
Storage Manager 7.02.

Vá para “Novo Processo de
Instalação” na página 30.

(tipo de máquina 3526) Subsistemas
de armazenamento existentes com
controladores que possuem versão de
firmware 3.x e Storage Manager
versão 6.22 sendo executados em um
sistema operacional Windows NT 4.0.

Upgrade do Windows NT para o
Windows 2000. Faça upgrade de
subsistemas de armazenamento com
controladores que utilizarão um
firmware versão 4.00.02 e serão
gerenciados com o Storage Manager
7.02 para Windows 2000.

Para fazer upgrade do firmware do
controlador de 3.x para 4.00.02, utilize
o processo de migração definido no
Guia de Suporte e Instalação do
Netfinity FAStT Storage Manager
Versão 7.02 para Windows NT.
Nota: Você deve fazer upgrade do
firmware do controlador da versão 3.x
para a 4.00.02 antes de fazer
upgrade do sistema operacional do
Windows NT para o Windows 2000.
Para fazer upgrade do Windows NT
para o Windows 2000, vá para
“Fazendo Upgrade do Windows NT
4.0 para o Windows 2000 em uma
Configuração Padrão” na página 13.

(tipos de máquinas 3526 e 3552)
Subsistemas de armazenamento
existentes com controladores que
possuem versões de firmware 4.00.00
a 4.00.01 executadas no sistema
operacional Windows NT 4.0.

Upgrade do Windows NT para o
Windows 2000 com subsistemas de
armazenamento que serão
gerenciados com o Storage Manager
7.02.

Vá para “Fazendo Upgrade do
Windows NT 4.0 para o Windows
2000 em uma Configuração Padrão”
na página 13.

© Copyright IBM Corp. 2000 29



Tabela 9. Determinando o processo de instalação (continuação)

Ambiente atual Ambiente planejado Ação

(tipos de máquinas 3526 e 3552)
Subsistemas de armazenamento
existentes com controladores que
possuem versões de firmware 4.00.00
a 4.00.01.

Faça upgrade de subsistemas de
armazenamento com controladores
que utilizarão um firmware versão
4.00.02 e serão gerenciados com o
Storage Manager 7.02.

1. Remova a instalação do Storage
Manager versão 7.0 ou 7.01.

2. Vá para “Novo Processo de
Instalação”.

3. Atualize o NVSRAM e o firmware
do controlador para a versão
4.00.02 utilizando a auxílio online
do software de gerenciamento de
armazenamento.

Novo Processo de Instalação
Comece a instalação do software de gerenciamento de armazenamento em
“Instalando o Pacote SM7client”. Continue o processo até ter concluído “Instalando
o Pacote SM7agent” na página 34.

A Figura 11 mostra um fluxograma do processo de instalação.

Instalando o Pacote SM7client
Utilize o seguinte procedimento para instalar o SM7client em cada estação de
gerenciamento que estiver configurada com um dos seguintes:

v Windows 2000 Server

v Windows 2000 Professional

v Windows 2000 Advanced Server (requerido para um ambiente de cluster)

Importante: Para instalar o SM7client em um host independente e gerenciar
subsistemas de armazenamento utilizando o caminho de E/S do Fibre Channel em
vez da rede, você deverá instalar o software TCP/IP no host e atribuir um endereço
IP estático para o host. O sistema operacional do host deverá estar executando o
Windows 2000 Server, o Windows 2000 Professional ou o Windows 2000 Advanced
Server (requerido para um ambiente de cluster).

Figura 11. Novo processo de instalação
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Instruções de Instalação
Antes de instalar o software, certifique-se de que:

v A estação de gerenciamento tenha, no mínimo, 35 MB de espaço disponível em
disco.

v As propriedades de vídeo estejam definidas com uma resolução de tela mínima
de 800 x 600 pixels e com uma paleta de 256 cores ou mais.

v Você tenha fechado todos os outros programas.

Para instalar o pacote SM7client:

1. Insira o CD IBM Netfinity FAStT Storage Manager na unidade de CD-ROM.

2.

Clique em Start → Settings → Control Panel → Add/Remove Programs . A
janela Add/Remove Programs Properties é aberta.

3. Clique em Install e siga as instruções que aparecem na tela.

4.

Clique em Browse .

5. Selecione a unidade de CD-ROM.

6. Selecione o diretório \W2K\SM7client.

7. Selecione o arquivo setup.exe e clique em Open .

8.

Clique em Next . A janela Welcome do programa de configuração é aberta.

9. Clique em Next para começar a instalação.

A janela Choose Destination Location é aberta.

10. Clique em Browse se desejar alterar a localização de destino.

11. Clique em Next .

12. Quando a instalação estiver concluída, clique em Finish .

Verificando a Instalação do SM7client
Utilize o seguinte procedimento para verificar se a instalação foi bem-sucedida:

1. Clique em Start → Programs .

2. Verifique se o Netfinity Fibre Channel Storage Manager 7 client aparece na lista
de programas.

3. Se você estiver instalando o SM7client em apenas uma estação de
gerenciamento, vá para o “Capítulo 5. Concluindo a Instalação” na página 51.
Caso contrário, vá para “Instalando o Pacote RDAC”.

Instalando o Pacote RDAC
Utilize o procedimento a seguir para instalar o pacote RDAC em um computador
host que esteja conectado a um ou mais subsistemas de armazenamento.

O RDAC contém o driver de dispositivo de vários caminhos, necessário para o
suporte de failover do controlador.

Importante: O RDAC deve ser instalado antes da instalação do pacote SM7agent.

Utilize o seguinte procedimento para instalar o RDAC em cada computador host
que tenha, no mínimo, 1 MB de espaço disponível em disco e esteja configurado
com um dos seguintes:

v Windows 2000 Server
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v Windows 2000 Professional

v Windows 2000 Advanced Server (requerido para um ambiente de cluster)

Atribuindo Letras de Unidade

Nota: Se você estiver instalando o software RDAC em uma configuração existente,
vá para “Instruções de Instalação”.

O procedimento de instalação instala o driver de dispositivo do RDAC antes do
driver de dispositivo do Windows 2000. Isso é necessário para ativar o RDAC.
Entretanto, isso significa que o sistema reconhece as unidades lógicas do
subsistema de armazenamento antes de reconhecer qualquer unidade local, e
atribui letras de unidade adequadamente.

Nota: Antes de instalar este software, você deve ter letras de unidade estáticas
atribuídas às unidades locais existentes.

Utilize o seguinte procedimento para determinar se você precisa atribuir letras de
unidade estáticas e atribuí-las, se necessário:

1. Desative o subsistema de armazenamento para evitar que o Administrador do
Disco (WINDISK) trave enquanto você está atribuindo letras de unidade e
instalando o driver de dispositivo RDAC.

2. Clique em Start → Programs → Administrative Tools → Computer
Management →Storage →Disk Management para exibir a configuração do disco
e verificar o número de partições.

v Se houver apenas uma partição, vá para a etapa 4.

v Se houver duas partições, vá para a etapa 3.

3. Se houver, no mínimo, duas partições, (a partição de reinicialização e uma
outra) e ambas as condições a seguir se aplicarem, vá para “Instruções de
Instalação”.

v A última partição foi criada com o Disk Management.

v A partição possui uma letra de unidade atribuída e um status de Unknown ou
um sistema de arquivos (isto é, tem um status diferente de Unformatted).

4. Utilize o procedimento a seguir para criar uma nova partição.

a. Selecione uma unidade que contenha espaço livre em disco e clique nela
com o botão direito do mouse.

A janela Write Signature and upgrade disk é aberta.

b. Clique em Partition → Create . A partição é criada (uma letra de unidade é
atribuída e o status da partição é unformatted).

c. Clique em Partition → Commit Changes Now . O status da partição é
alterado para Unknown e as letras de unidade estáticas são atribuídas a
todas as partições existentes.

5. Continue em “Instruções de Instalação”.

Instruções de Instalação
Antes de instalar o software, certifique-se de que:

v Você tenha privilégios de Administrador no computador host.

v O computador host esteja configurado com o Windows 2000 Server, o Windows
2000 Professional ou o Windows 2000 Advanced Server.

v O computador host tenha, no mínimo, 1 MB de espaço disponível em disco.
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v As propriedades de vídeo estejam definidas com uma resolução de tela mínima
de 640 x 480 pixels e com uma paleta de 256 cores ou mais.

v Você tenha fechado todos os outros programas.
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Para instalar o pacote RDAC:

1. Insira o CD IBM Netfinity FAStT Storage Manager na unidade de CD-ROM.

2. Clique em Start → Settings → Control Panel → Add/Remove Programs .

A janela Remove Programs Properties é aberta.

3. Clique em Install e siga as instruções que aparecem na tela.

4. Clique em Browse .

A janela Browse é aberta.

5. Selecione a unidade de CD-ROM.

6. Selecione o diretório \W2K\RDAC.

7. Selecione o arquivo setup.exe e clique em Open .

8. Clique em Next .

A janela Welcome do programa de configuração é aberta.

9. Clique em Next para começar a instalação.

Quando o RDAC estiver instalado, a janela Setup Complete abrirá.

10. Clique em No, I will restart my computer later ; em seguida, clique em
Finish .

11. Vá para “Instalando o Pacote SM7agent”.

Instalando o Pacote SM7agent
Utilize o procedimento a seguir para instalar o SM7agent em cada computador host
conectado a um ou mais subsistemas de armazenamento. O SM7agent consiste
nos seguintes componentes:

v O software do agente de host, necessário para gerenciamento do agente de host
dos subsistemas de armazenamento.

v O utilitário SM7devices, utilizado para exibir a relação de unidades lógicas com
nomes de dispositivos do sistema operacional. Para obter mais informações,
consulte “Usando o Utilitário SM7devices” na página 65.

Importante: Não será possível instalar o SM7agent, a não ser que o RDAC esteja
instalado. Você deve instalar o SM7agent mesmo se não pretender gerenciar
subsistemas de armazenamento por meio do software SM7agent.

Instruções de Instalação
Antes de instalar o software, certifique-se de que:

v Você tenha privilégios de Administrador no computador host.

v O computador host esteja configurado com o Windows 2000 Server, o Windows
2000 Professional ou o Windows 2000 Advanced Server (requerido para um
ambiente de cluster).

v O computador host tenha, no mínimo, 1 MB de espaço disponível em disco.

v As propriedades de vídeo estejam definidas com uma resolução de tela mínima
de 640 x 480 pixels e com uma paleta de 256 cores ou mais.

v Você tenha instalado o RDAC.

v Você tenha fechado todos os outros programas.
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Para instalar o SM7agent:

1. Insira o CD IBM Netfinity FAStT Storage Manager na unidade de CD-ROM.

2. Clique em Start → Settings → Control Panel → Add/Remove Programs .

A janela Add/Remove Programs Properties é aberta.

3. Clique em Install e siga as instruções que aparecem na tela.

4. Clique em Browse .

A janela Browse é aberta.

5. Selecione a unidade de CD-ROM.

6. Selecione o diretório \W2K\SM7agent.

7. Selecione o arquivo setup.exe e clique em Open .

8. Clique em Next .

A janela Welcome do programa de configuração é aberta.

9. Clique em Next para começar a instalação.

Quando o SM7agent estiver instalado, a janela Setup Complete será aberta.

10. Você deverá reiniciar o host para garantir que todas as alterações sejam
efetivadas. Clique em Finish para reiniciar o host.

Verificando a Instalação do RDAC
Utilize o seguinte procedimento para verificar se a instalação do pacote RDAC foi
bem-sucedida:

Nota: Certifique-se de que todos os subsistemas de armazenamento estejam
conectados ao host e ativados.

1. Dê um clique com o botão direito do mouse em My Computer.

2. Clique em Manage → System Tools → System Information → Software
Environment → Drivers . A janela Services é aberta.

3. Role pela lista de drivers até encontrar rdacfltr.

4. Rdacfltr deve ser exibido com o tipo de estado Running e status OK. Caso
contrário, reinstale o RDAC.

Verificando a Instalação do SM7agent
Utilize o seguinte procedimento para verificar se a instalação do SM7agent foi
bem-sucedida:

Nota: Certifique-se de que todos os subsistemas de armazenamento estejam
conectados ao host e ativados.

1. Clique em Start → Programs → Administrative Tools → Services . A janela
Services é aberta.

2. Role pela lista de serviços até encontrar o Netfinity Fibre Channel Storage
Manager 7 agent.

3. O SM7agent deverá ser exibido com o tipo de inicialização Automatic e status
Started. Caso contrário, reinstale o SM7agent.

4. Se estiver fazendo upgrade de uma versão anterior do software de
gerenciamento de armazenamento, utilize o procedimento no auxílio online do
software de gerenciamento de armazenamento para fazer download da versão
mais recente de NVSRAM e do firmware do controlador. Caso contrário, vá
para a etapa 5.

5. Se planeja utilizar o software do agente de host para gerenciar um ou mais
subsistemas de armazenamento, vá para o “Capítulo 5. Concluindo a
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Instalação” na página 51.
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6. Se você não planeja utilizar o software do agente de host para gerenciar um ou
mais subsistemas de armazenamento, desative o serviço do agente de host no
procedimento a seguir.

7.

a. Selecione Start → Programs → Administrative Tools → Services .

b. Na lista de serviços exibidos, dê um clique com o botão direito do mouse no
agente de host.

c. Selecione Properties → Startup Type → selecione Manual no menu drop
down.

d. Selecione OK.

8. Vá para o “Capítulo 5. Concluindo a Instalação” na página 51.
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Capítulo 4. Instalando o Software em um Ambiente de
Servidor de Cluster

Este capítulo descreve como instalar o software de gerenciamento de
armazenamento na configuração de vários hosts, utilizando o software do servidor
de cluster. O processo de instalação a ser utilizado dependerá do ambiente do
subsistema de armazenamento. Consulte a Tabela 10.

Importante: Sempre verifique se há um arquivo README em qualquer mídia de
instalação. Ele pode conter informações importantes que não estavam disponíveis
quando este Guia de Suporte e Instalação foi preparado. Para garantir uma
instalação adequada, certifique-se de ter lido todo o conteúdo do capítulo 1,
incluindo a documentação de suporte relacionada no “Capítulo 1. Introdução” na
página 1. Todas as tarefas de preparação descritas no “Capítulo 2. Preparando
para Instalação” na página 13 devem ser concluídas.

Processo de Pré-instalação
Há duas configurações nas quais você pode instalar o software de gerenciamento
de armazenamento:

v A que não tem subsistemas de armazenamento existentes.

v A que tem subsistemas de armazenamento existentes.

Utilize a Tabela 10 para determinar um processo de instalação.

Tabela 10. Determinando o processo de instalação

Ambiente atual Ambiente planejado Ação

Subsistemas de armazenamento
não-existentes

Novos subsistemas de
armazenamento com controladores
que utilizarão um firmware versão
4.00.02 e serão gerenciados com o
Storage Manager Versão 7.02.

Vá para “Novo Processo de
Instalação” na página 30.

Subsistemas de armazenamento
existentes com controladores que
possuem versão de firmware 3.x e
software de gerenciamento de
armazenamento versão 6.22 sendo
executados em um sistema
operacional Windows NT 4.0. (tipo de
máquina 3526)

Upgrade do Windows NT para o
Windows 2000. Faça upgrade de
subsistemas de armazenamento com
controladores que utilizarão um
firmware versão 4.00.02 e serão
gerenciados com o Storage Manager
Versão 7.02 para Windows 2000.

Para fazer upgrade do firmware do
controlador de 3.x para 4.00.02, utilize
o processo de migração para
configuração de cluster definido no
Guia de Suporte e Instalação do
Netfinity FAStT Storage Manager
Versão 7.02 para Windows NT.
Nota: Você deve fazer upgrade do
firmware do controlador da versão 3.x
para a 4.00.02 antes de fazer
upgrade do sistema operacional do
Windows NT para o Windows 2000.
Para fazer upgrade do Windows NT
para o Windows 2000, vá para
“Fazendo Upgrade do Windows NT
4.0 para o Windows 2000 em uma
Configuração Padrão” na página 13.
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Tabela 10. Determinando o processo de instalação (continuação)

Ambiente atual Ambiente planejado Ação

Subsistemas de armazenamento
existentes com controladores que
possuem versões de firmware 4.00.00
a 4.00.01. (tipos de máquinas 3526 e
3552)

Upgrade do Windows NT para o
Windows 2000 com subsistemas de
armazenamento que serão
gerenciados com o Storage Manager
Versão 7.02.

Vá para “Fazendo Upgrade do
Windows NT 4.0 para o Windows
2000 em uma Configuração de
Cluster” na página 13.

Subsistemas de armazenamento
atualizados com controladores que
utilizarão um firmware versão 4.00.02
e serão gerenciados com o Storage
Manager Versão 7.02.

1. Remova a instalação do Storage
Manager versão 7.0 ou 7.01.

2. Vá para “Novo Processo de
Instalação” na página 30.

3. Atualize o NVSRAM e o firmware
para a versão 4.00.02 por meio do
auxílio online do software de
gerenciamento de
armazenamento.

Nova Instalação
Antes de começar uma instalação com subsistemas de armazenamento existentes,
consulte a documentação de instalação do hardware para obter a configuração
específica requerida para que o hardware consiga operar o software de
gerenciamento de armazenamento em uma configuração de cluster.

Se você tiver uma estação de gerenciamento conectada a uma rede Ethernet,
instale o SM7client e conclua a instalação para uma instalação do host. Consulte a
Figura 12 na página 41 para obter o novo processo de instalação.

Importante: Depois de conectar os subsistemas de armazenamento a ambos os
nós, não inicie o Windows 2000 nos nós ao mesmo tempo, até você instalar o
software do cluster em pelo menos um nó. Para suspender a inicialização do
Windows 2000 no nó B, pressione a barra de espaços na inicialização do OS
(sistema operacional). Não instale o software do cluster até que receba instrução
para isso.
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Instalando o Pacote SM7client
Instale o pacote SM7client em cada estação de gerenciamento. O pacote pode ser
instalado em um host, no nó A ou nó B, ou em ambos os nós, A e B, configurados
com o Windows 2000 Advanced Server. Instale o software TCP/IP no computador
host e atribua um endereço IP estático. Certifique-se de que o SM7client esteja
instalado em cada estação de gerenciamento que estiver configurada com um dos
seguintes:

v Windows 2000 Server

v Windows 2000 Professional

v Windows 2000 Advanced Server (requerido para um ambiente de cluster)

Importante: Para instalar o SM7client em um host independente e gerenciar
subsistemas de armazenamento utilizando o caminho de E/S do Fibre Channel em
vez da rede, você deverá instalar o software TCP/IP no host e atribuir um endereço
IP estático para o host. O sistema operacional do host deverá estar executando o
Windows 2000 Advanced Server, o Windows 2000 Professional ou o Windows 2000
Advanced Server (requerido para um ambiente de cluster).

Se você estiver instalando o SM7client em apenas uma estação de gerenciamento,
vá para o “Capítulo 5. Concluindo a Instalação” na página 51.

Instruções de Instalação
Antes de instalar o software, certifique-se de que:

v Cada estação de gerenciamento tenha, no mínimo, 35 MB de espaço disponível
em disco.

v As propriedades de vídeo estejam definidas com uma resolução de tela mínima
de 800 x 600 pixels e com uma paleta de 256 cores ou mais.

v Você tenha fechado todos os outros programas.

Para instalar o SM7client:

1. Insira o CD de instalação IBM Netfinity FAStT Storage Manager na unidade de
CD-ROM.

2. Clique em Start → Settings → Control Panel → Add/Remove Programs .

A janela Add/Remove Programs Properties é aberta.

3. Clique em Install e siga as instruções que aparecem na tela.

4.

Clique em Browse . A janela Browse é aberta.

5. Selecione a unidade de CD-ROM.

6. Selecione o diretório \W2K\SM7client.

7. Selecione o arquivo setup.exe e clique em Open .

8.

Clique em Next . A janela Welcome do programa de configuração é aberta.

9.

Clique em Next para começar a instalação. A janela Choose Destination
Location é aberta.

Figura 12. Processo para uma nova instalação
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10. Clique em Browse para alterar a localização de destino.

11. Clique em Next para começar a instalação.

12. Quando a instalação estiver concluída, clique em Finish .

Verificando a Instalação do SM7client
Utilize o seguinte procedimento para verificar se a instalação foi bem-sucedida:

1. Clique em Start → Programs .

2. Verifique se o Netfinity Fibre Channel Storage Manager 7 client aparece na lista
de programas.

3. Se você estiver instalando o SM7client em apenas uma estação de
gerenciamento, vá para o “Capítulo 5. Concluindo a Instalação” na página 51.

Instalando o Pacote RDAC
Utilize o procedimento a seguir para instalar o pacote RDAC em cada computador
host que esteja conectado a um ou mais subsistemas de armazenamento.

O RDAC contém o driver de dispositivo de vários caminhos, necessário para o
suporte de failover do controlador.

Utilize o procedimento das seções a seguir para instalar o RDAC em cada
computador host que tenha, no mínimo, 1 MB de espaço disponível em disco e
esteja configurado com o Windows 2000 Advanced Server (requerido para um
ambiente de cluster).

Atribuindo Letras de Unidade
O procedimento de instalação instala o driver de dispositivo do RDAC antes do
driver de dispositivo do Windows 2000. Isso é necessário para ativar o RDAC.
Entretanto, isso significa que o sistema reconhece as unidades lógicas do
subsistema de armazenamento antes de reconhecer qualquer unidade local, e
atribui letras de unidade adequadamente.

Nota: Antes de instalar esse software, é necessário que se tenha letras de
unidade estáticas atribuídas às unidades locais existentes.

Utilize o seguinte procedimento para determinar se você precisa atribuir letras de
unidade estáticas e atribuí-las, se necessário:

1. Desative o subsistema de armazenamento para evitar que o Administrador do
Disco (WINDISK) trave enquanto você está atribuindo letras de unidade e
instalando o driver de dispositivo RDAC.

2. Clique em Start → Programs → Administrative Tools → Computer
Management →Storage →Disk Management para exibir a configuração do
disco e verificar o número de partições.

v Se houver apenas uma partição, vá para a etapa 4.

v Se houver duas partições, vá para a etapa 3.

3. Se houver, no mínimo, duas partições (a partição de reinicialização e uma
outra), e ambas as condições a seguir se aplicarem, vá para “Instruções de
Instalação” na página 43.

v A última partição foi criada com o Disk Management e

v A partição possui uma letra de unidade atribuída e um status de Unknown ou
um sistema de arquivos (isto é, um status diferente de Unformatted).

4. Utilize o procedimento a seguir para criar uma nova partição.
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a. Selecione uma unidade que contenha espaço livre em disco e clique nela
com o botão direito do mouse.

A janela Write Signature and Upgrade Disk é aberta.

b. Clique em Partition → Create . A partição é criada (uma letra de unidade é
atribuída e o status da partição é Unformatted).

c. Clique em Partition → Commit Changes Now . O status da partição é
alterado para Unknown e as letras de unidade estáticas são atribuídas a
todas as partições existentes.

5. Continue em “Instruções de Instalação”.

Instruções de Instalação
Antes de instalar o software, certifique-se de que:

v Você tenha privilégios de Administrador no computador host.

v O computador host esteja configurado com o Windows 2000 Advanced Server.

v O computador host tenha, no mínimo, 1 MB de espaço disponível em disco.

v As propriedades de vídeo estejam definidas com uma resolução de tela mínima
de 640 x 480 pixels e com uma paleta de 256 cores ou mais.

v Você tenha fechado todos os outros programas.

Para instalar o pacote RDAC:

1. Insira o CD IBM Netfinity FAStT Storage Manager na unidade de CD-ROM.

2. Clique em Start → Settings → Control Panel → Add/Remove Programs .

A janela Remove Programs Properties é aberta.

3. Clique em Install e siga as instruções que aparecem na tela.

4. Clique em Browse .

A janela Browse é aberta.

5. Selecione a unidade de CD-ROM.

6. Selecione o diretório \W2K\RDAC.

7. Selecione o arquivo setup.exe e clique em Open .

8. Clique em Next .

A janela Welcome do programa de configuração é aberta.

9. Clique em Next para começar a instalação.

Quando o RDAC estiver instalado, a janela Setup Complete abrirá.

10. Se você estiver instalando o pacote do agente de host, vá para “Instalando o
Pacote SM7agent”.

11. Clique em No, I will restart my computer later ; em seguida, clique em
Finish .

12. Vá para “Instalando o Pacote SM7agent”.

Instalando o Pacote SM7agent
Utilize o procedimento a seguir para instalar o SM7agent em cada computador host
no cluster planejado que esteja conectado a um ou mais subsistemas de
armazenamento. O SM7agent consiste nos seguintes componentes:

v O software Storage Manager 7 Agent, necessário para gerenciamento do agente
de host dos subsistemas de armazenamento.

v O utilitário SM7devices, necessário para relacionar unidades lógicas com nomes
de dispositivos do sistema operacional. Para obter mais informações, consulte
“Usando o Utilitário SM7devices” na página 65.

Capítulo 4. Instalando o Software em um Ambiente de Servidor de Cluster 43



Importante: Não será possível instalar o SM7agent, a não ser que RDAC esteja
instalado. Você deve instalar o SM7agent mesmo se não pretender gerenciar
subsistemas de armazenamento por meio do software SM7agent.

Instruções de Instalação
Antes de instalar o software, certifique-se de que:

v Você tenha privilégios de Administrador no computador host.

v O computador host esteja configurado com o Windows 2000 Advanced Server
(requerido para um ambiente de cluster).

v O computador host tenha, no mínimo, 1 MB de espaço disponível em disco.

v As propriedades de vídeo estejam definidas com uma resolução de tela mínima
de 640 x 480 pixels e com uma paleta de 256 cores ou mais.

v Você tenha instalado o RDAC.

v Você tenha fechado todos os outros programas.

Para instalar o SM7agent:

1. Insira o CD IBM Netfinity FAStT Storage Manager na unidade de CD-ROM.

2. Clique em Start → Settings → Control Panel → Add/Remove Programs .

A janela Add/Remove Programs Properties é aberta.

3. Clique em Install e siga as instruções que aparecem na tela.

4. Clique em Browse .

A janela Browse é aberta.

5. Selecione a unidade de CD-ROM.

6. Selecione o diretório \W2K\SM7agent.

7. Selecione o arquivo setup.exe e clique em Open .

8. Clique em Next .

A janela Welcome do programa de configuração é aberta.

9. Clique em Next para começar a instalação.

Quando o SM7agent estiver instalado, a janela Setup Complete abrirá.

10. Você deverá reiniciar o host para garantir que todas as alterações sejam
efetivadas. Clique em Finish para reiniciar o host.

Verificando a Instalação do RDAC
Utilize o seguinte procedimento para verificar se a instalação do pacote RDAC foi
bem-sucedida:

Nota: Certifique-se de que todos os subsistemas de armazenamento estejam
conectados ao host e ativados.

1. Dê um clique com o botão direito do mouse em My Computer.

2. Clique em Manage → System Tools → System Information → Software
Environment → Drivers . A janela Services é aberta.

3. Role pela lista de drivers até encontrar rdacfltr.

4. Rdacfltr deve ser exibido com o tipo de estado Running e status OK. Caso
contrário, reinstale o RDAC.

5. Vá para “Verificando a Instalação do SM7agent” na página 45.
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Verificando a Instalação do SM7agent
Utilize o seguinte procedimento para verificar se a instalação do SM7agent foi
bem-sucedida:

Nota: Certifique-se de que todos os subsistemas de armazenamento estejam
conectados ao host e ativados.

1. Clique em Start → Programs → Administrative Tools → Services . A janela
Services é aberta.

2. Role pela lista de serviços até encontrar o Netfinity Fibre Channel Storage
Manager 7 agent.

3. O SM7agent deverá ser exibido com o tipo de inicialização Automatic e status
Started. Caso contrário, reinstale o SM7agent.

4. Se estiver fazendo upgrade de uma versão anterior do software de
gerenciamento de armazenamento, utilize o procedimento no auxílio online do
software de gerenciamento de armazenamento para fazer download da versão
mais recente de NVSRAM e do firmware do controlador. Caso contrário, vá
para a etapa 5.

5. Se planeja utilizar o software do agente de host para gerenciar um ou mais
subsistemas de armazenamento, vá para “Continuando a Instalação”. Caso
contrário, poderá desativar o serviço de agente de host utilizando o seguinte
procedimento:

a. Selecione Start → Programs → Administrative Tools → Services .

b. Na lista de serviços exibidos, dê um clique no agente de host com o botão
direito do mouse.

c. Selecione Properties → Startup Type → selecione Manual no menu drop
down.

d. Selecione OK.

Continuando a Instalação
Se você instalou o software de gerenciamento de armazenamento no nó A, vá para
“Configurando os Subsistemas de Armazenamento”. Se você instalou o software de
gerenciamento de armazenamento no nó B, vá para “Verificando Letras de
Unidade” na página 46.

Configurando os Subsistemas de Armazenamento
Utilize os procedimentos do “Capítulo 5. Concluindo a Instalação” na página 51
para executar as seguintes tarefas:

1. Iniciar o Enterprise Management e executar uma Initial Automatic Discovery de
subsistemas de armazenamento na sub-rede local. Consulte “Iniciando o
Enterprise Management” na página 51.

2. Adicionar outros dispositivos ao domínio de gerenciamento, conforme
necessário. Para obter mais informações, consulte “Adicionando Dispositivos”
na página 53.

3. Criar todas as matrizes e unidades lógicas planejadas em cada subsistema de
armazenamento conectado ao cluster; consulte “Criando Matrizes e Unidades
Lógicas” na página 54

4. Abrir uma janela Subsystem Management para cada subsistema de
armazenamento e configurar o subsistema de armazenamento o máximo
possível. Não é necessário configurar completamente os subsistemas de
armazenamento. Entretanto, qualquer alteração feita posteriormente deverá ser
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reconhecida pelo Nó B; consulte “Executando Outras Tarefas de Gerenciamento
do Subsistema de Armazenamento” na página 57.

5. Modificar definições de configuração no NVSRAM executando os scripts
apropriados requeridos para sua configuração; consulte “Modificando Definições
de Configuração no NVSRAM” na página 57

6. Depois de concluir o procedimento no “Capítulo 5. Concluindo a Instalação” na
página 51, continue na etapa 7.

7. Se você instalou o software de gerenciamento de armazenamento no nó A, vá
para “Encerrando o Nó A”. Se você instalou o gerenciamento de
armazenamento no nó B, vá para “Verificando Letras de Unidade”.

Verificando Letras de Unidade
Importante: Não execute este procedimento até que tenha instalado os
componentes do software de gerenciamento de armazenamento necessários em
ambos os nós, A e B.

1. Selecione Start → Programs → Administrator Tools → Computer Management
→ Storage → Disk Management para verificar se as letras de unidade atribuídas
às unidades lógicas configuradas são as mesmas das atribuídas ao nó A.

2. Continue em “Encerrando o Nó B”.

Encerrando o Nó A
1. Encerre o Windows 2000, mais deixe o nó A executando (não desative o nó).

2. Volte para “Instalando o Pacote SM7client” na página 41 e repita os
procedimentos de instalação para instalar os componentes de software
necessários no nó B.

Encerrando o Nó B
1. Encerre o Windows 2000, mais deixe o nó B executando (não desative o nó).

2. Continue na seção seguinte, “Instalando o Software do Servidor de Cluster”.

Instalando o Software do Servidor de Cluster
Utilize o procedimento a seguir para instalar o software do servidor de cluster nos
nós A e B.

Importante: Antes de instalar o software do servidor de cluster, certifique-se de
que tenha instalado o software de gerenciamento de armazenamento em ambos os
nós do servidor de cluster.

1. Instale o software do servidor de cluster no nó A, como a seguir:

a. Consulte a documentação apropriada do MSCS (Microsoft Cluster Server)
para obter o procedimento correto de instalação do software do servidor de
cluster.

Nota: Durante a instalação, especifique se você deseja Formar um Novo
Cluster.

b. Instale o cluster no nó A. Depois de o sistema ser reiniciado, deixe o nó A
em execução.

2. Instale o software do servidor de cluster no nó B. Depois de o sistema ser
reiniciado, deixe o nó B em execução.
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a. Consulte a documentação apropriada do MSCS para obter o procedimento
correto de instalação do software do servidor de cluster.

Nota: Durante a instalação, especifique se você deseja Unir-se ao Cluster
Existente.

b. Depois de o sistema ser reiniciado, deixe o nó B instalado e em execução.

Importante: Quando a instalação do MSCS estiver concluída, certifique-se de
reinstalar o mais recente Service Pack suportado.

3. Verifique a instalação do software, como a seguir:

a. Em ambos os nós (A ou B), clique em Start → Programs → Administrative
Tools(Common) .

b. Clique em Cluster Administrator.

c. No campo Cluster ou Server Name, digite o nome do cluster ou o nome ou
endereço IP de um dos nós.

d. Se a instalação for bem-sucedida, os nomes de computador dos nós
aparecerão do lado esquerdo da janela Cluster Administrator.

4. Se os nomes de ambos os nós aparecerem, vá para “Concluindo as Tarefas
Finais” na página 58. Caso contrário, reinstale o software do servidor de cluster.
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Fazendo Upgrade de uma Versão Anterior do Software de
Gerenciamento de Armazenamento em uma Configuração de Servidor
de Cluster

Certifique-se de estar familiarizado com as etapas requeridas em um novo
processo de instalação antes de continuar com os procedimentos de upgrade a
seguir.

Você pode escolher um dos dois procedimentos a seguir para fazer upgrade do
subsistema de armazenamento existente para o Storage Manager 7.02 e do
firmware do controlador para a versão 4.00.02.

v Executando um upgrade programado: Significa programar o tempo inativo do
servidor de cluster para fazer upgrade do firmware do controlador e do software
de gerenciamento de armazenamento. O upgrade programado é o procedimento
preferido para fazer upgrade de uma configuração do servidor de cluster.

v Executando um upgrade com funções em andamento: Significa fazer
upgrade do firmware do controlador e do software de gerenciamento de
armazenamento de forma que os serviços e os recursos oferecidos pelo cluster
estejam sempre disponíveis, enquanto o nó do qual se está fazendo upgrade
não está disponível.

Importante: Depois de fazer upgrade do firmware do controlador do subsistema de
armazenamento para 4.00.02, você não conseguirá se comunicar com o
controlador até fazer upgrade para o software Storage Manager 7.02 na estação de
gerenciamento e no host. Versões de software do cliente de gerenciamento de
armazenamento ou do agente de host instaladas anteriormente não reconhecerão
controladores que estiverem executando firmware versão 4.00.02.

Executando um Upgrade Programado do Software de Gerenciamento
de Armazenamento Versão 7.0 ou 7.01 para o Storage Manager 7.02

Conclua as etapas a seguir para fazer upgrade do software de gerenciamento de
armazenamento versão 7.0 ou 7.01 para o Storage Manager 7.02.

1. Antes de instalar o software de gerenciamento de armazenamento, faça o
seguinte:

a. Clique em Start → Programs → Administrative Tools → Services . A janela
de serviços é aberta.

b. Na lista de serviços exibidos, dê um clique em Cluster Server com o botão
direito do mouse. Em seguida, clique em Manual .

c. Pare o servidor de cluster em todos os nós na configuração do cluster.

2. Encerre todos os nós, exceto o nó A, na configuração do cluster.

3. No nó A, para remover a instalação dos componentes da versão anterior do
software de gerenciamento de armazenamento, utilize o procedimento de
remoção da instalação fornecido com a versão do software de gerenciamento
de armazenamento que você está executando.

4. Verifique se as versões do driver da placa de barramento do host da IBM são
atuais. Se não forem atuais, consulte o arquivo README localizado no diretório
\W2K\Host_Adapter no CD de instalação para fazer upgrade das versões de
driver antes de continuar.

5. Para Instalar o pacote Storage Manager 7.02 SM7client, consulte o
procedimento em “Instalando o Pacote SM7client” na página 41.
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6. Para Instalar o pacote Storage Manager 7.02 RDAC, consulte o procedimento
em “Instalando o Pacote RDAC” na página 42.

7. Para Instalar o pacote Storage Manager 7.02 SM7agent, consulte o
procedimento em “Instalando o Pacote SM7agent” na página 43.

8. Faça upgrade do controlador NVSRAM e do firmware do controlador para a
versão 4.00.02. Em seguida, modifique as definições de configuração
apropriadas no NVSRAM utilizando “Modificando Definições de Configuração no
NVSRAM” na página 57.

Nota: Você ainda pode utilizar o firmware de controlador das versões 4.00.00 à
4.00.01 existentes. Os subsistemas de armazenamento existentes
podem ser gerenciados com o Storage Manager 7.02.

9. Encerre o nó A.

10. No nó B, repita a etapa 3 na página 48 até a etapa 7 na mesma página; em
seguida, repita a etapa 9.

11. Todos os nós devem ser encerrados. Inicialize um nó de cada vez e conclua o
seguinte:

a. Clique em Start → Programs → Administrative Tools → Services . A janela
de serviços é aberta.

b. Na lista de serviços exibidos, dê um clique em Cluster Server com o botão
direito do mouse. Clique em Automatic para alterar a opção de
inicialização do servidor de cluster.

c. Inicie o servidor de cluster no nó B.

Executando um Upgrade com Funções em Andamento do Software de
Gerenciamento de Armazenamento Versão 7.0 ou 7.01 para o Storage
Manager 7.02

Nota: Para evitar a perda de acesso a um cluster, será necessário executar um
upgrade com funções em andamento. Isso significa fazer upgrade de forma
que os serviços e os recursos oferecidos pelo cluster estejam sempre
disponíveis, mesmo se o nó do qual se está fazendo upgrade não estiver
disponível. Se houver aplicativos instalados no ambiente de servidor de
cluster que não suportem um upgrade com funções em andamento, execute
um dos seguintes procedimentos:

v Coloque esses recursos offline antes do upgrade; coloque-os novamente
online após o upgrade ou,

v Utilize um método diferente de upgrade

Conclua as etapas a seguir para executar um upgrade com funções em andamento
do software de gerenciamento de armazenamento versão 7.0 ou 7.01 para o
Storage manager 7.02.

1. No nó A, abra o cluster administrator.

2. Selecione o nó A e File → Pause Node para interromper o nó.

3. Dê um clique duplo na pasta Active Groups na janela à direita do cluster
administrator.

4. Selecione cada grupo relacionado e mova sua seleção para o nó B.

5. No nó A, para remover a instalação dos componentes da versão anterior do
software de gerenciamento de armazenamento, utilize o procedimento de
remoção da instalação que vem com a versão do software de gerenciamento
de armazenamento que você está executando.
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6. Verifique se as versões do driver da placa de barramento do host da IBM são
atuais. Se não forem atuais, consulte o arquivo README, localizado no
diretório \W2K\Host_Adapter no CD de instalação, para fazer upgrade das
versões de driver antes de continuar.

7. Para Instalar o pacote Storage Manager 7.02 SM7client, consulte o
procedimento em “Instalando o Pacote SM7client” na página 41.

8. Para Instalar o pacote Storage Manager 7.02 RDAC, consulte o procedimento
em “Instalando o Pacote RDAC” na página 42.

9. Para Instalar o pacote Storage Manager 7.02 SM7agent, consulte o
procedimento em “Instalando o Pacote SM7agent” na página 43.

10. Faça upgrade do firmware do controlador para a versão 4.00.02. Em seguida,
modifique as definições de configuração apropriadas no NVSRAM. Consulte
“Modificando Definições de Configuração no NVSRAM” na página 57.

Nota: Você ainda pode utilizar o firmware de controlador das versões 4.00.00
à 4.00.01 existentes. Os subsistemas de armazenamento existentes
podem ser gerenciados com o Storage Manager 7.02.

11. Execute o Cluster Administrator e continue no nó selecionando File → Resume
Node .

12. Repita as etapas de 1 a 9 na página 44 e repita a etapa 11 para o nó B.
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Capítulo 5. Concluindo a Instalação

Este capítulo contém procedimentos para iniciar o Enterprise Management e o
Subsystem Management e para concluir as tarefas de instalação.

Iniciando o Enterprise Management
Enterprise Management é a primeira janela a ser aberta quando o software é
iniciado. Utilize essa janela para:

v Adicionar e descobrir os subsistemas de armazenamento que você deseja
gerenciar.

v Fornecer uma exibição abrangente de todos os subsistemas de armazenamento
em seu domínio de gerenciamento.

v Executar tarefas de gerenciamento do subsistema de armazenamento batch
utilizando o Script Editor.

Utilize o seguinte procedimento para iniciar a janela Enterprise Management:

1. Clique em Start → Programs .

2. Clique em Netfinity Fibre Channel Storage Manager 7 client .

O software de cliente é iniciado, exibindo a janela Enterprise Management e a
janela Confirm Initial Automatic Discovery, conforme mostrado na Figura 13 na
página 52.
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Nota: A janela Enterprise Management pode levar vários minutos para abrir.
Não há a exibição de um cursor de espera (uma ampulheta, por
exemplo). Para não executar a descoberta automática inicial, clique em
No. É possível utilizar a opção Edit → Add Device do menu de opções
para adicionar hosts e subsistemas de armazenamento. Para obter mais
informações, consulte “Adicionando Dispositivos” na página 53.

3. Clique em Yes para iniciar uma descoberta automática inicial de hosts e
subsistemas de armazenamento conectados à sub-rede local na qual a estação
de gerenciamento está instalada.

O software envia uma mensagem de difusão através da sub-rede local na qual
a estação de gerenciamento está instalada. Ele descobrirá subsistemas de
armazenamento gerenciados pelo agente de host se os hosts que fornecem
conexões de gerenciamento de rede aos subsistemas de armazenamento
responderem à difusão. O software descobrirá subsistemas de armazenamento
gerenciados diretamente se os controladores nesses subsistemas responderem
à mensagem de difusão.

Importante: Pode levar até um minuto para que a janela Enterprise Management
seja atualizada após uma descoberta automática inicial.

Figura 13. Janela Confirm Initial Automatic Discovery
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Se for necessário parar a operação de descoberta automática, feche a janela
Enterprise Management.

Quando a descoberta automática inicial estiver concluída, você poderá ver todos os
hosts e subsistemas de armazenamento conectados à sub-rede local, conforme
mostrado na Figura 14.

Caso não veja todos os hosts e subsistemas de armazenamento, faça o seguinte:

v Verifique se há possíveis problemas no hardware e nas conexões (consulte a
documentação do hardware para obter procedimentos específicos).

v Consulte o tópico de auxílio online do Enterprise Management sobre como
descobrir subsistemas de armazenamento.

v Certifique-se de que o dispositivo esteja na sub-rede local. Se não estiver, você
deverá utilizar a opção Add Device.

Nota: Se algum dispositivo mostrar um status de Unresponsive, utilize o software
para remover o dispositivo do domínio de gerenciamento e depois
adicione-o novamente. Consulte o auxílio online do Enterprise Management
para obter instruções sobre como remover e adicionar dispositivos.

Um subsistema de armazenamento poderá ser duplicado na árvore de dispositivos
após uma descoberta automática, se o subsistema de armazenamento for
gerenciado diretamente, mas estiver conectado a um host com o software de
agente de host instalado e em execução. Nesse caso, é possível remover o ícone
de gerenciamento de armazenamento duplicado da árvore de dispositivos utilizando
a opção de remoção de dispositivo da janela Enterprise Management.

Continue em “Adicionando Dispositivos”.

Adicionando Dispositivos
É possível adicionar mais hosts ou subsistemas de armazenamento fora da
sub-rede local. Para obter mais informações sobre essa opção, consulte o auxílio
online da janela Enterprise Management.

Importante: Se você estiver gerenciando subsistemas de armazenamento por meio
do software do agente de host e adicionar fisicamente novos subsistemas de

Figura 14. Janela Enterprise Management
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armazenamento, deverá parar e reiniciar o serviço do agente de host para que ele
possa reconhecer os novos subsistemas de armazenamento (consulte “Parando o
Serviço de Agente de Host” na página 58). Em seguida, vá para a janela Enterprise
Management e clique em Tools → Rescan para adicionar os novos subsistemas de
armazenamento ao domínio de gerenciamento.

Continue em “Criando Matrizes e Unidades Lógicas”.

Criando Matrizes e Unidades Lógicas
Para criar uma matriz ou uma unidade lógica, execute o seguinte procedimento:

1. Destaque um subsistema de armazenamento na janela Enterprise Management
e selecione Tools → Manage Device para iniciar uma janela Subsystem
Management para esse subsistema.

2. Crie todas as matrizes e unidades lógicas planejadas nesse subsistema de
armazenamento utilizando a opção Configure → Create Array/Logical Drive .

3. Repita a configuração das matrizes/unidade lógica de cada subsistema de
armazenamento conectado ao cluster.

Nota: Se você fizer qualquer outra adição ou exclusão da unidade lógica,
deverá fazer com que sejam reconhecidas pelo nó B em uma
configuração do cluster.

4. Vá para “Configurando Notificações de Alerta”.

Configurando Notificações de Alerta
Depois de adicionar dispositivos ao domínio de gerenciamento, configure as
opções de notificação de alerta para relatar eventos críticos nos subsistemas de
armazenamento. As seguintes opções estão disponíveis para notificação de alerta:

v Notificação a uma NMS (estação de gerenciamento de rede) designada
utilizando os traps do SNMP (Simple Network Management Protocol) (consulte
“Configurando o NMS para Notificação do SNMP” para obter mais informações).

v Notificação a endereços de e-mail designados.

v Notificação a pagers alfanuméricos designados (quando um pacote de software
de outro fabricante é utilizado para converter mensagens de e-mail).

Nota: A Janela Enterprise Management deve permanecer aberta para monitorar a
condição de subsistemas de armazenamento incluídos no domínio de
gerenciamento. Você pode optar por minimizar a janela. Se essa janela for
fechada, você não receberá notificações de alerta. Consulte o auxílio online
da janela Enterprise Management para obter mais informações sobre
opções de notificação de alerta.

Configurando o NMS para Notificação do SNMP
Se você escolher configurar a notificação de alerta utilizando os traps do SNMP,
deverá primeiro copiar um arquivo MIB (management information base) para a
estação de gerenciamento de rede designada. Utilize este procedimento para
configurar o MIB na estação de gerenciamento de rede.

Importante: Você só precisa configurar o NMS designado uma vez.

1. Copie o arquivo Arrayman.mib do diretório \W2K\SM7mib no CD de Instalação
para a estação de gerenciamento de rede.

2. Siga as etapas requeridas por sua estação de gerenciamento de rede
específica para compilar o MIB.
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Nota: Para obter detalhes sobre as etapas requeridas, consulte o
administrador da rede ou a documentação específica para o produto
NMS que está sendo utilizado.

Configurando os Destinos de Alerta
Configure os destinos do trap do SNMP e os destinos de e-mail das notificações de
alerta utilizando a janela Enterprise Management. Consulte o auxílio online do
Enterprise Management para obter os procedimentos específicos.

Vá para “Iniciando o Gerenciamento de Subsistema”.

Iniciando o Gerenciamento de Subsistema
A janela Subsystem Management permite gerenciar subsistemas selecionados.

Utilize o procedimento a seguir para abrir uma janela Subsystem Management para
um subsistema de armazenamento selecionado:

1. Na janela Enterprise Management, selecione um subsistema de
armazenamento.

2. Clique em Tools → Manage Device .

O software exibe a janela Subsystem Management para o subsistema de
armazenamento selecionado, conforme mostrado na Figura 15.

Nota: Utilizando a janela Subsystem Management aberta, é possível gerenciar
apenas o subsistema de armazenamento selecionado. Entretanto, você
pode abrir várias janelas Subsystem Management para gerenciar outros
subsistemas de armazenamento.

3. Vá para “Renomeando Subsistemas de Armazenamento”.

Renomeando Subsistemas de Armazenamento
Ao iniciar o Storage Manager 7.02 pela primeira vez, os subsistemas de
armazenamento estão sem nome. Você deve utilizar a janela Subsystem
Management para renomear cada subsistema de armazenamento a partir de
<unnamed> para o nome que você deseja. Consulte os nomes digitados no
registro de informações que você criou utilizando a Tabela 12 na página 71. Em
seguida, consulte o tópico renomeando subsistemas de armazenamento no auxílio

Figura 15. Janela Subsystem Management
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online do Subsystem Management. O tópico de auxílio fornece instruções
detalhadas para renomeação de subsistemas de armazenamento.
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Executando Outras Tarefas de Gerenciamento do Subsistema de
Armazenamento

As tarefas de gerenciamento do subsistema de armazenamento que podem ser
executadas são as seguintes:

v Fazer download do firmware do controlador

v Fazer download do controlador NVSRAM

v Localizar um subsistema de armazenamento

v Exibir um perfil do subsistema de armazenamento

v Informar ou alterar uma senha do subsistema de armazenamento

v Criar e gerenciar unidades lógicas e subsistemas

v Utilizar o Performance Monitor

v Criar partições de armazenamento (se aplicável)

Nota: Para criar partições de armazenamento, é necessário obter o nome mundial
ou o nome da porta de cada placa de host em cada host conectado ao
subsistema de armazenamento.

Para obter mais informações sobre essas e outras tarefas de gerenciamento do
subsistema de armazenamento, consulte os tópicos apropriados no auxílio online
do Subsystem Management.

Vá para “Modificando Definições de Configuração no NVSRAM”.

Modificando Definições de Configuração no NVSRAM
Dependendo do sistema operacional, do método de gerenciamento (agente de host
ou direto) e da configuração (cluster ou não-cluster) que estiverem sendo
utilizados, poderá ser necessário executar scripts para modificar definições de
configuração armazenadas no NVSRAM em cada subsistema de armazenamento
que estiver sendo gerenciado com o Storage Manager 7.02.

Utilize o seguinte procedimento para modificar as definições de configuração
apropriadas.

1. Insira o CD de instalação do IBM Netfinity FAStT Storage Manager na unidade
de CD-ROM da estação de gerenciamento.

2. Vá para o diretório \W2K\Scripts e leia o arquivo README nesse diretório.

3. Destaque um subsistema de armazenamento na janela Enterprise Management
e clique em Tools → Execute Script .

4. Você instalou o software de gerenciamento de armazenamento em uma
configuração padrão (não-cluster)? Consulte a tabela a seguir.
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Sim Não

Execute os scripts para ativar o sistema operacional
Windows 2000.

a. Para instalar e executar o script do Windows 2000:

1) Selecione File → Load Script. A janela Load Script
é aberta.

2) Selecione o script apropriado no diretório
\W2K\Scripts no CD de instalação.

3) Selecione Open para instalar o script.

4) Selecione Tools → Execute Only . Aguarde até que
a mensagem Script Execution Complete seja
exibida.

Vá para a etapa 5 na página 52.

Execute os scripts para ativar o sistema operacional e o
cluster do Windows 2000. Se você não estiver
gerenciando subsistemas de armazenamento diretamente,
execute o script para desativar a rede.

a. Para instalar e executar o script do Windows 2000:

a.

1) Selecione File → Load Script. A janela Load Script
é aberta.

2) Selecione o script apropriado no diretório
\W2K\Scripts no CD de instalação.

3) Selecione Open para instalar o script.

4) Selecione Tools → Execute Only . Aguarde até que
a mensagem Script Execution Complete seja
exibida.

b. Para instalar e executar o script de desativação da
rede:

1) Clique em File → Load Script . A janela load script
é aberta.

2) Para desativar a rede, selecione o script
apropriado a partir do diretório \W2K\Scripts no
CD de instalação.

3) Clique em Open para instalar o script.

4) Clique em Tools → Execute Only . Aguarde até
que a mensagem Script Execution Complete seja
exibida.

5) Vá para a etapa 5 na página 52.

Nota: O NVSRAM padrão possui o cluster ativado.
Depois da execução do script Clustering Off, você deve
executar o script Clustering On para ativar o cluster.

5. Repita os procedimentos da etapa 3 na página 51 até a etapa 4 para cada
subsistema de armazenamento que estiver sendo gerenciado com o software
de gerenciamento de armazenamento.

6. Se você tiver uma configuração padrão, vá para “Concluindo as Tarefas Finais”.
Caso contrário, vá para a etapa 7.

7. Se você tiver uma configuração de cluster, vá para a etapa 6 em “Configurando
os Subsistemas de Armazenamento” na página 45.

Concluindo as Tarefas Finais
Para gerenciar subsistemas de armazenamento utilizando apenas o método direto,
vá para “Parando o Serviço de Agente de Host”. Caso contrário, vá para o
“Capítulo 6. Suporte do Sistema Operacional” na página 61.

Nota: É possível gerenciar subsistemas de armazenamento utilizando os métodos
de gerenciamento direto e pelo agente de host.

Parando o Serviço de Agente de Host
Utilize o seguinte procedimento para parar o serviço de agente de host:

1. Clique em Start → Programs → Administrative Tools → Services .

2. Clique no serviço Netfinity Fibre Channel Storage Manager 7 Agent .
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3. Clique em Stop .

4. Clique em Startup .

A janela Service é aberta.

5. Em Startup Type, clique em Manual .

6. Clique em OK.

7. Clique em Close para fechar a janela Services e, em seguida, feche o Painel
de Controle.

8. Vá para o “Capítulo 6. Suporte do Sistema Operacional” na página 61.
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Capítulo 6. Suporte do Sistema Operacional

Este capítulo contém informações relacionadas à operação do software de
gerenciamento de armazenamento em um ambiente Windows 2000.

Entendendo as Restrições do Windows 2000
Importante: Sempre verifique se há um arquivo README em qualquer mídia de
instalação. Ele pode conter informações importantes que não estavam disponíveis
quando este Guia de Suporte e Instalação foi preparado.

A Tabela 11 explica as restrições que se aplicam ao utilizar o Storage Manager 7.02
com o Windows 2000.

Tabela 11. Restrições e notas do Windows 2000

Restrição Solução

No auxílio online, clicar nas setas de rolagem vertical
(para cima ou para baixo) faz com que a caixa de
rolagem seja movida completamente para a extremidade
oposta da barra de rolagem.

Esse é um defeito conhecido no ambiente de tempo de
execução JavaHelp. Clique na caixa de rolagem e
deslize-a até alcançar a posição desejada na janela Help.

Depois de tentar adicionar um dispositivo de host ao
domínio de gerenciamento de mais de cinco clientes, os
subsistemas de armazenamento gerenciados pelo agente
de host conectados a esse host tornam-se indiferentes.

Uma única ocorrência do software de agente de host
pode comunicar-se apenas com cinco clientes ou menos.

Há limites sobre quanta capacidade de espaço de
unidade se pode ter em um único grupo de unidade
lógica. Por exemplo, com unidades de 73,4 GB, o número
máximo de unidades que podem ser configuradas em um
único grupo de unidade lógica é 29.

Nenhuma.

As informações de senha são armazenadas em uma área
reservada de cada unidade no subsistema de
armazenamento. Cada unidade armazena uma cópia
espelhada dos dados de senha. Sem unidades no
subsistema de armazenamento, o software de
gerenciamento de armazenamento não encontra os dados
da senha quando você tenta operações protegidas por
senhas. Adicione uma das unidades ao subsistema de
armazenamento e tente a operação novamente.

As informações de senha são armazenadas em uma área
reservada de cada unidade no subsistema de
armazenamento. Cada unidade armazena uma cópia
espelhada dos dados de senha. Sem unidades no
subsistema de armazenamento, o software de
gerenciamento de armazenamento não encontra os dados
da senha quando você tenta operações protegidas por
senhas. Adicione uma das unidades ao subsistema de
armazenamento e tente a operação novamente.

A migração da matriz não é suportada porque poderia
causar perda de configuração. Número de problema
desconhecido. Migração da matriz é quando você remove
um conjunto de unidades configuradas com matrizes de
um subsistema de armazenamento e as insere em outro
subsistema de armazenamento.

Ligue para o serviço IBM para obter assistência.

Uma configuração independente (não colocada em rede),
na qual o host do Windows 2000 não tenha o software
TCP/IP instalado, não é suportada.

Instale o software TCP/IP no host do Windows 2000 e
atribua ao host um endereço IP estático.
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Tabela 11. Restrições e notas do Windows 2000 (continuação)

Restrição Solução

Se você configurar um novo subsistema de
armazenamento com um único controlador, deverá
colocar o controlador no slot superior (slot A) para os
tipos de máquinas 3552 e 3526 ou no slot da esquerda
para o tipo de máquina 3542. O firmware do controlador
não pode reconhecer ou comunicar-se com um único
controlador até que o slot A seja ocupado. Essa restrição
não se aplica aos subsistemas de armazenamento que
foram configurados originalmente com dois controladores.
Problema desconhecido. Viking 1, plataforma cruzada.

Nenhuma.

Ocorre um failover do controlador em um par ativo/ativo
de controladores e a propriedade das matrizes são
transferidas do proprietário preferencial com defeito para
o outro controlador do par. O controlador com defeito será
substituído e ficará online até que a propriedade da matriz
seja transferida novamente para o controlador
ownerProblem 44591 preferencial. Apenas no Windows.

Imediatamente após substituir o controlador, selecione a
opção storage subsystem → Redistribute Arrays na
janela Subsystem Management para redistribuir as
Matrizes novamente para os proprietários de
controladores preferenciais. Para obter mais informações,
consulte o auxílio online da janela Subsystem
Management.

Depois de instalar o software do agente de host, você
verá uma mensagem de erro com “Service Error 100” no
host.

As causas incluem: O software do agente de host não
encontra nenhum controlador com versão de firmware 4.x.
Os controladores com versão de firmware 4.x possuem o
volume de acesso desativado com as definições de
configuração de NVSRAM. O NVSRAM nos controladores
em um subsistema de armazenamento que você está
tentando gerenciar contém um número de unidade lógica
de volume de acesso que já está em uso por outra
unidade lógica. O NVSRAM nos controladores em um
subsistema de armazenamento que você está tentando
gerenciar contém um número de unidade lógica de
volume de acesso que não é suportado pelo sistema
operacional e correções instaladas. Por exemplo, o
volume de acesso está configurado no LUN 32, mas o
sistema operacional e os pacotes de serviços suportam
apenas 8 LUNs.

Existe uma possibilidade de corrupção no sistema de
arquivos quando os recursos são movidos para frente e
para trás várias vezes entre os nós de cluster que
utilizam o Microsoft Cluster Server em execução no
Windows 2000 Advanced Server. Quando o recurso de
cluster é movido, o nó proprietário esvazia a cache e
depois libera a reserva para uma ou mais unidades
lógicas. O outro nó reserva, então, uma ou mais unidades
lógicas. Em algumas ocorrências, as leituras e gravações
do sistema de arquivos não terminam antes da liberação.
Isso resulta em um conflito de reserva e na corrupção do
sistema de arquivos. Tentar recuperar-se utilizando o
comando chkdsk farácom que as informações do sistema
de arquivos sejam corrigidas de forma que alguns
arquivos não fiquem mais acessíveis. Número do
problema 43808; apenas no Windows.

Nenhuma. É muito improvável que o problema ocorra
durante situações normais de failover.

Número de Unidades Lógicas Suportadas
Há limites no número de unidades lógicas (LUNs) que pode ser utilizado para
acessar as unidades lógicas em um único subsistema de armazenamento. Os
limites de unidades lógicas suportadas são os seguintes:
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v O Windows 2000 suporta até 8 unidades lógicas por subsistema de
armazenamento (LUNs 0–7).

v O Windows 2000 suportará até 32 unidades lógicas por subsistema de
armazenamento (LUNs 0–31) se a placa de host também suportar LUNs
grandes e estiver configurada corretamente.

v As placas de host suportam um número máximo de unidades lógicas. Consulte a
documentação da placa de host para obter informações específicas.

v O método de gerenciamento do agente de host utiliza uma unidade lógica
especial, chamada de volume de acesso, para se comunicar com os
controladores no subsistema de armazenamento. O volume de acesso utiliza
uma das unidades lógicas permitidas. Portanto, gerenciar subsistemas de
armazenamento com o software de agente de host o limita a um LUN a menos
que o número máximo suportado pelo Windows 2000 e pela placa de host.

Criando Unidades Lógicas
Uma unidade lógica é um objeto lógico que é a estrutura básica que você cria para
armazenar dados no subsistema de armazenamento. Uma unidade lógica é
configurada por meio de um subsistema com um nível específico de RAID para
atender necessidades do aplicativo quanto à disponibilidade de dados e
desempenho de E/S do Fibre Channel. Uma unidade lógica é reconhecida pelo
sistema operacional como uma unidade. É possível adicionar ou excluir unidades
lógicas em uma configuração padrão (não-cluster) e em um ambiente de servidor
de cluster.

Configuração Padrão (Não-cluster)
Quando você cria novas unidades lógicas com o software de gerenciamento de
armazenamento, é necessário adicionar as novas unidades lógicas ao sistema
operacional Windows 2000. Lembre-se de que cada unidade lógica (não matriz) é
reconhecida pelo Windows 2000 como uma unidade.

Você pode usar o utilitário SM7devices para identificar unidades lógicas pelos
nomes de dispositivos associados do sistema operacional. Para obter mais
informações, consulte “Ambiente do Servidor de Cluster” na página 64.

1. Utilize o software de gerenciamento de armazenamento para criar uma nova
unidade lógica. Para obter instruções específicas, consulte o auxílio online do
Subsystem Management.

2. Para adicionar unidades lógicas ao nó A:

a. Selecione Start →Programs → Administrator Tools →Computer
Management Storage → Disk Management .

b. Em System Tools, clique em Device Manager .

c. Clique com o botão direito do mouse em Disk Drives para varrer as
alterações de hardware.

3. Selecione Start →Programs → Administrator Tools → Computer Management
→ Storage → Disk Management (local) para formatar a nova unidade lógica no
nó A.

Atenção: Antes de excluir as unidades lógicas com o software de gerenciamento
de armazenamento ou utilizando Configure → Reset Configuration , pare toda a
atividade de entrada e saída para o subsistema de armazenamento afetado. Em
seguida, utilize o Disk Management para excluir as partições e para retirar a
atribuição de letras de unidade associadas às unidades lógicas. Se você não
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utilizar o Disk Management primeiro, as informações de registro serão danificadas.
Reinicie o sistema para remover as informações de configuração.

Ambiente do Servidor de Cluster
Quando você cria unidades lógicas em um nó em um ambiente de servidor de
cluster, também é necessário atribuir a mesma letra de unidade no outro nó.

Você pode usar o utilitário SM7devices para identificar unidades lógicas pelos
nomes de dispositivos associados do sistema operacional.

1. Utilize o software de gerenciamento de armazenamento para criar uma nova
unidade lógica. Para obter instruções específicas, consulte o auxílio online do
Subsystem Management.

2. Para adicionar unidades lógicas ao nó A:

a. Selecione Start →Programs → Administrator Tools →Computer
Management Storage → Disk Management .

b. Em System Tools, clique em Device Manager .

c. Clique com o botão direito do mouse em Disk Drives para varrer as
alterações de hardware.

3. Selecione Start →Programs → Administrator Tools → Computer Management
→ Storage → Disk Management (local) para formatar a nova unidade lógica no
nó A.

Utilize o seguinte procedimento para adicionar unidades lógicas em um ambiente
de servidor de cluster:

1. Utilize o software de gerenciamento de armazenamento para criar uma nova
unidade lógica. Para obter instruções específicas, consulte o auxílio online do
Subsystem Management.

2. Para adicionar unidades lógicas ao nó B:

a. Selecione Start →Programs → Administrator Tools → Computer
Management Storage → Disk Management .

b. Em System Tools, clique em Device Manager .

c. Clique com o botão direito do mouse em Disk Drives para varrer as
alterações de hardware.

3. Para formatar a nova unidade lógica no nó B:

a. Selecione Start →Programs → Administrator Tools → Computer
Management → Storage →Disk Management para formatar a nova
unidade lógica no nó B.

4. Inicie o Cluster Administrator no nó B e utilize-o para parar o serviço de cluster.

5. Clique em Node B → File Stop → Cluster Service .

6. Em Cluster Administrator, clique em Node B e, depois, em File → Evict Cluster
Node .

7. Reinicie o nó A.

8. No nó A, utilize o Cluster Administrator para criar um novo subsistema ou
selecione um subsistema existente ao qual você possa adicionar a nova
unidade lógica.

9. Destaque o grupo de unidade lógica e clique em File → New → Resource .

10. Nomeie o novo recurso e clique em Physical Disk como o tipo de recurso.

11. Clique em Next .

12. Clique em node A como o proprietário do recurso de disco e, em seguida,
clique em Next .
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13. Especifique as dependências (outros recursos que o Cluster Administrator
deve colocar online) antes de esse novo recurso de disco ser colocado online.

14. Selecione o novo disco na lista de parâmetros de unidades e clique em
Finish .

15. Remova a instalação do software Cluster Server do nó B.

16. Reinstale o software Cluster Server no nó B e una o cluster existente que
inclui o nó A.

Importante: Edite as propriedades do novo disco para permitir que o nó B seja um
possível proprietário do recurso. É possível redistribuir os recursos de cluster entre
os nós A e B e editar as propriedades de todos esses recursos para incluir o nó B.
Mova qualquer recurso de cluster pertencente ao nó B do nó A para o nó B.

Usando o Utilitário SM7devices
O software SM7agent inclui um utilitário chamado SM7devices que permite a você
exibir a unidade lógica do subsistema de armazenamento que está associada a um
determinado nome de dispositivo do sistema operacional. Essa capacidade é útil
quando você deseja criar letras de unidade ou partições para a unidade lógica
utilizando o Disk Administrator.

Depois de concluir a criação das unidades lógicas em um determinado subsistema
de armazenamento, vá para o host conectado a esse subsistema e execute as
seguintes etapas para utilizar o SM7devices:

1. Em um prompt de comandos do DOS, mude para o diretório \Program
Files\SM7agent.

2. Digite:

SM7devices

3. Pressione Enter .

O software exibe informações de identificação do dispositivo. Por exemplo,
você poderá ver:

\\.\PHYSICALDRIVE0 [Storage Subsystem Finance, Logical Drive DEBIT, LUN
0, WWN <600a0b800006028600000000382060eb>] \\.\PHYSICALDRIVE1
[Storage Subsystem Finance, Logical Drive CREDIT, LUN 1, WWN
<600a0b70006028600000000392060eb>]

onde PHYSICALDRIVE x = Diskx no Disk Management Storage Subsystem = o
nome do subsistema de armazenamento logical drive = o nome da unidade
lógica LUN = o número da unidade lógica associado à unidade lógica WWN = o
nome da world wide para a unidade lógica

Parando e Iniciando o Agente de Host
Utilize o procedimento das seções a seguir para parar e iniciar o software do
agente de host instalado no host.

Nota: Se um volume de acesso não for detectado após um reinício, ocorrerá a
parada da execução do software do agente de host automaticamente.
Reinicie o host para que novos subsistemas de armazenamento gerenciados
pelo agente de host possam ser descobertos.
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Parando o Agente de Host
Você deverá parar o software do agente de host se desejar adicionar os
subsistemas de armazenamento. Ao reiniciar o serviço, o agente de host descobre
os novos subsistemas de armazenamento e os adiciona ao domínio de
gerenciamento. Para parar o agente de host:

1. Selecione Start → Settings → Control Panel → Services .

A caixa de diálogo Services aparece.

2. Selecione Netfinity Fibre Channel Storage Manager 7 Agent.

3.

Selecione Stop .

Iniciando o Agente de Host
O software do agente de host é iniciado automaticamente depois de o host ser
reiniciado. Entretanto, ele deverá ser iniciado manualmente caso você o pare para
adicionar subsistemas de armazenamento.

Para iniciar o agente de host:

1. Selecione Start → Settings → Control Panel → Services .

A caixa de diálogo Services aparece.

2. Selecione Netfinity Fibre Channel Storage Manager 7 Agent.

3. Selecione Start .
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Removendo a Instalação dos Componentes do Software de
Gerenciamento de Armazenamento

Utilize o procedimento a seguir caso seja necessário remover a instalação de um
ou mais componentes do Storage Manager 7.02.

Importante: Não remova a instalação do componente RDAC, a não ser que tenha
recebido instrução de um representante de serviço. O pacote do agente de host
requer que o RDAC funcione adequadamente. Se a instalação do RDAC for
removida em um ambiente de coexistência, você perderá o suporte de failover do
caminho de E/S do Fibre Channel de ambos os sistemas, da versão 7.02 e da
versão 6.22.

1. Clique em Start → Settings → Control Panel → Add/Remove Programs .

A janela Add/Remove Programs Properties é aberta.

2. Selecione, na lista de programas, o componente do qual deseja remover a
instalação.

Por exemplo, Netfinity Fibre Channel Storage Manager 7 Client.

3. Selecione Add/Remove .

A janela Confirm File Deletion é aberta.

4. Clique em Yes para iniciar o processo de remoção da instalação.

5. Quando a remoção da instalação estiver concluída, clique em OK.
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Apêndice A. Avisos

Referências nesta publicação a produtos, programas ou serviços IBM não
significam que a IBM pretenda torná-los disponíveis em todos os países onde
opera. Qualquer referência a produtos, programas ou serviços IBM não significa
que apenas produtos, programas ou serviços IBM possam ser utilizados. Este
produto está sujeito à propriedade intelectual da IBM ou a outros direitos protegidos
por lei. Qualquer produto, programa ou serviço funcionalmente equivalente, que
não infrinja quaisquer direitos de propriedade intelectual da IBM, poderá ser
utilizado em substituição a este produto, programa ou serviço. A avaliação e
verificação da operação em conjunto com outros produtos, programas e serviços,
exceto aqueles expressamente designados pela IBM, são de inteira
responsabilidade do usuário.

A IBM pode ter patentes ou solicitações pendentes de patentes relativas a assuntos
tratados nesta publicação. O fornecimento desta publicação não lhe garante direito
algum sobre tais patentes. Consultas sobre licenças devem ser enviadas, por
escrito, para:

Gerencia de Relações Comerciais e Industriais da IBM Brasil AV. Pasteur, 138/146
Botafogo - Rio de Janeiro -RJ Cep: 22.290.240 - Brasil

Esta seção contém marcas e outras informações importantes.

Referências nesta publicação a sites não IBM são fornecidas apenas para
conveniência e não representam de forma alguma um endosso a esses sites. O
material nesses sites da Web não são parte do material desse produto IBM e o uso
dos sites é de sua responsabilidade.

Avisos sobre esta Edição
A INTERNATIONAL BUSINESS MACHINES CORPORATION FORNECE ESTA
PUBLICAÇÃO “NO ESTADO”, SEM GARANTIA DE ESPÉCIE ALGUMA,
EXPLÍCITA OU IMPLÍCITA, INCLUINDO, MAS NÃO SE LIMITANDO ÀS
GARANTIAS IMPLÍCITAS DE COMERCIALIZAÇÃO OU ADEQUAÇÃO A UM FIM
ESPECÍFICO. Algumas jurisdições não permitem a exclusão de garantias explícitas
ou implícitas em certas transações; portanto, esta disposição pode não se aplicar a
você.

Esta publicação pode conter imprecisões técnicas ou erros tipográficos.
Periodicamente são feitas alterações nas informações aqui contidas; tais alterações
serão incorporadas em futuras edições desta publicação. A IBM pode realizar
aperfeiçoamentos e/ou alterações nos produtos e/ou programas descritos nesta
publicação, a qualquer momento.

Esta publicação pode conter referências ou informações sobre produtos IBM
(máquinas e programas), programação ou serviços que não estejam anunciados
em seu país. Tais referências ou informações não significam que a IBM pretenda
anunciar tais produtos, programas ou serviços em seu país.

Pedidos de informações técnicas sobre produtos IBM devem ser encaminhadas a
um Representante de Marketing IBM. Nenhuma parte desta publicação pode ser
reproduzida ou distribuída, de qualquer forma ou por quaisquer meios, sem a
prévia permissão, por escrito, da International Business Machines Corporation.
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Todos os direitos reservados.

Nota aos usuários dos Estados Unidos — Documentação relaciona a direitos
restritos — O uso, duplicação ou divulgação estão sujeitos a restrições definidas no
GSA ADP Schedule Contract com a IBM Corp.

Marcas
Os termos a seguir são marcas da International Business Machines Corporation
nos Estados Unidos e/ou em outros países:

IBM

Netfinity

JavaHelp é uma marca da Sun Microsystems, Inc. nos Estados Unidos e/ou em
outros países.

Microsoft, Windows e Windows NT são marcas da Microsoft Corporation nos
Estados Unidos e/ou em outros países.

UNIX é marca registrada da The Open Group nos Estados Unidos e em outros
países.

Outros nomes de empresas, produtos e serviços podem ser marcas ou serviço de
terceiros.
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Apêndice B. Registro das Informações do
Subsistema/Controlador de Armazenamento

A Tabela 12 fornece uma planilha de dados na qual você pode registrar nomes do
subsistema de armazenamento, tipos de gerenciamento, endereços Ethernet do
hardware e endereços IP. Faça uma cópia dessa tabela e conclua as informações
dos subsistemas e controladores de armazenamento. Utilize as informações
registradas na Tabela 12 para configurar a tabela BOOTP para o servidor de rede e
para a tabela do host ou do DNS (Domain Name System). As informações da
Tabela 12 ajudam a adicionar subsistemas de armazenamento após a instalação
inicial. Os títulos das colunas mostram uma referência de página para que se
obtenha instruções detalhadas sobre como obter as informações. Para obter um
registro de informações de amostra, consulte a Tabela 7 na página 19.

Tabela 12. Registro das informações do subsistema e controlador de armazenamento

Nome do
subsistema de
armazenamento
(consulte a página
19)

Tipo de gerenciamento
(consulte a página 15)

Controladores — Endereços Ethernet e
IP e nome do host (consulte a página
19)

Host — Endereço IP
e nome do host
(consulte a página
23)

Nome do subsistema
de armazenamento:

Nome do subsistema
de armazenamento:

Nome do subsistema
de armazenamento:

Nome do subsistema
de armazenamento:

Nome do subsistema
de armazenamento:

Nome do subsistema
de armazenamento:

Nome do subsistema
de armazenamento:

Nome do subsistema
de armazenamento:
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